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About This Guide

Filr 3.1 Installation and Upgrade Are Not Documented in This Guide

IMPORTANT: Filr 3.1 is only available as an online update to Filr 3.0.
+ To Install a New Filr 3.1 Appliance: Install Filr 3.0 using this guide, then follow the instructions
in the Filr 3.1 Release Notes to apply the 3.1 update.

+ To Upgrade to Filr 3.1: Use the instructions in the Filr 3.1 Release Notes to apply the 3.1
update.

Best Practice Deployments

To create a production-viable, best practice Filr deployment, complete the sections below in the order
presented.

+ Chapter 1, “Overview,” on page 9

¢ Chapter 2, “Planning Is Critical,” on page 11

+ Chapter 3, “System Requirements,” on page 13

+ Chapter 4, “Setting Up Shared Storage,” on page 23

+ Chapter 5, “Downloading and Preparing the Filr Software,” on page 27
+ Chapter 6, “Deploying the Virtual Machines,” on page 31

+ Chapter 7, “Starting and Configuring the Appliances,” on page 45

+ Chapter 8, “Creating an Expandable Filr Deployment,” on page 51

+ Chapter 9, “Setting Up Filr Services,” on page 67

Test and Evaluation Deployments
To create an evaluation or test deployment, see the following sections.

+ Appendix B, “All-in-One (Small) Deployment—Creating,” on page 111

and

+ Appendix E, “Non-Expandable Deployment—Creating,” on page 129
Upgrade Instructions
To upgrade existing deployments, see

¢ Chapter 11, “Upgrading a Large Filr Deployment,” on page 81

+ Appendix C, “All-in-One (Small) Deployment—Upgrading,” on page 113
Audience

This guide is intended for Filr Administrators.

About This Guide


../../filr-relnote3-1/data/filr-relnote3-1.html
../../filr-relnote3-1/data/filr-relnote3-1.html

Feedback

We want to hear your comments and suggestions about this manual and the other documentation
included with this product. Please use the comment on this topic link at the bottom of each page of
the online documentation.

Documentation Updates

For the most recent version of this guide, visit the Filr 3.0 Documentation web site (http://
www.novell.com/documentation/filr-3).

Additional Documentation

For other documentation on Filr 3.0, see the Filr 3.0 Documentation web site (http://www.novell.com/
documentation/filr-3).
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Overview

IMPORTANT: Filr 3.1 is only available as an online update to Filr 3.0.

+ To Install a New Filr 3.1 Appliance: Install Filr 3.0 using this guide, then follow the instructions
in the Filr 3.1 Release Notes to apply the 3.1 update.

What Is Micro Focus Filr?

Micro Focus Filr is an enterprise file sharing tool that leverages your current file server and security
infrastructure to provide multi-device access to organizational and personal files.

Filr
‘j ‘ N
¢ (N o
eDirectory Filr Access Firewall NetWare
Users Devices
Comments =
|
w ) (- /g
Active : OES
Directory My Files
Users
| Net Folders m/
'i | ® Windows
Other Q
Internal Search
Users @ ~
' Sharing SharePoint
External @
Users Synchronization
— -/ - Filr Data Disk

For more detail about this illustration and for more illustrations and explanations, see the Filr :
Understanding How Filr Works.

What Is “Filr Clustering”?

“Filr clustering” is a term that is sometimes used in the Filr product and means that multiple Filr
appliances access a shared storage location, which contains deployment-level configuration settings
and data. “Filr clustering” provides a measure of

+ Fault tolerance

Overview
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And
+ High availability

“Filr clustering” is not related to Novell Cluster Services.

This guide refers to “Filr-clustered” deployments as “Expandable” deployments.

10 Filr 3.0 Installation, Deployment, and Upgrade Guide



Planning Is Critical

IMPORTANT: Filr 3.1 is only available as an online update to Filr 3.0.

+ To Install a New Filr 3.1 Appliance: Install Filr 3.0 using this guide, then follow the instructions
in the Filr 3.1 Release Notes to apply the 3.1 update.

Creating a successful Filr deployment requires that you

1. Involve pertinent stakeholders.
2. Conduct a thorough needs assessment.
3. Plan your deployment based on the needs assessment.

The instructions that follow assume that you have:

1. Completed the planning processes outlined in the Filr Planning Your Filr Deployment—Best
Practices guide.

2. Filled in the Filr 3.0 Planning Worksheets associated with the Planning Best Practices guide.

Planning Is Critical 11
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System Requirements

IMPORTANT: Filr 3.1 is only available as an online update to Filr 3.0.

+ To Install a New Filr 3.1 Appliance: Install Filr 3.0 using this guide, then follow the instructions

in the Filr 3.1 Release Notes to apply the 3.1 update.

Expandable Deployments Are the Focus of This Guide

Other deployment types are covered in

*

*

The following sections outline platform, version, and other requirements for your expandable Filr

Appendix B, “All-in-One (Small) Deployment—Creating,” on page 111
Appendix E, “Non-Expandable Deployment—Creating,” on page 129.

deployment.

*

*

“Administrative Workstations and Browsers” on page 13
“Appliance Disk Space” on page 14

“Appliance Memory and CPU” on page 14

“Appliance Shared Storage (/vashare Mount Point) Platforms” on page 14
“Desktop Platforms (for the Desktop Application)” on page 15
“Desktop Web Application Access” on page 16

“File Servers (Backend Storage)” on page 17

“Filr Software” on page 18

“IP Addresses” on page 18

“LDAP Directory Services (Users and Groups)” on page 19
“Mobile Device Platforms” on page 19

“SQL Database Server” on page 20

“Virtualization Hypervisor Platform” on page 21

Administrative Workstations and Browsers

Table 3-1 Administrative Workstations and Browsers

Platform Browser Requirement
Windows, Mac, or Linux Mozilla Firefox Latest version
Capable of running a listed browser Microsoft Internet Explorer 11
Microsoft Edge Latest version
Chrome Latest version
Safari Latest version

System Requirements

13
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Appliance Disk Space

+ See Worksheet 25—Storage Planning Summary

Planning for disk space varies widely according to organization needs and the planning process is
covered in the Filr Planning Your Filr Deployment—Best Practices guide.

General guidelines are summarized in the following sections of the Planning Best Practices guide:

+ Filr Appliance Sizing Guidelines
+ Filrsearch Appliance Sizing Guidelines
¢ SQL Server Sizing Guidelines

For an overview of Filr storage, see “Appliance Storage lllustrated” in the Filr : Understanding How
Filr Works.

Appliance Shared Storage (/vashare Mount Point) Platforms

+ See Worksheet 25—Storage Planning Summary

The Filr appliances in an Expandable deployment access a commonly-shared CIFS or NFS storage
disk that you will identify and create in Chapter 4, “Setting Up Shared Storage,” on page 23.

Table 3-2 Shared Storage Platforms (/vashare Mount Point)

Protocol Requirement
CIFS * A Windows-based CIFS share
NFS Exported mount point on one of the following:

* SLES 11 SP4
¢ SLES 12

NFS on Windows is not supported.

Appliance Memory and CPU

Table 3-3 Memory and CPU

Appliance Recommended Minimum
Filr + 12 GB RAM + 8 GB RAM
2 GB Operating System 1.5 GB Operating System
10 GB Java Heap 6.5 GB Java Heap
¢ 4 CPUs + 4 CPUs
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Appliance Recommended Minimum

Filrsearch Less than 1,000 Users Same
* 8GB RAM
2 GB Operating System
2 GB Memcached

4 GB Java Heap
* 2CPUs

More than 1,000 Users
¢ 12 GB RAM
2 GB Operating System
3 GB Memcached

7 GB Java Heap
* 2CPUs

MySQL Less than 1,000 Users Same

+ 8 GB RAM
* 2CPUs

More than 1,000 Users

¢ 12 GB RAM
¢ 2CPUs

Desktop Platforms (for the Desktop Application)

For more information about the Filr desktop application, see the Desktop for Windows Quick Start or
the Desktop for Mac Quick Start.

Table 3-4 Desktop Platforms (Desktop Application)

Platform Versions

Windows IMPORTANT: Always make sure that the latest patches and support packs are installed.

* Windows 7 SP1 (x86 & x64)
+ Windows 8.1 (x64 only)
+ Windows 10 (x64 only)

Mac IMPORTANT: Always make sure that the latest patches and support packs are installed.

+ 10.11 (El Capitan)
+ 10.12 (Sierra)

System Requirements 15
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Desktop Web Application Access
Three components apply:

+ A Browser
+ Java
+ An Office Application

Table 3-5 Browsers for Web Application Access

Platform Requirement
Linux Mozilla Firefox; Google Chrome (latest versions)
Windows Microsoft Edge

Microsoft Internet Explorer 11

Mozilla Firefox; Google Chrome (latest versions)

Mac Safari; Mozilla Firefox (latest versions)

Table 3-6 Java for Web Application Functionality

Version Functionality

Javavl.7.0 72 + Editing files with Edit-in-Place as described in
the Filr : User Access Guide.

+ Uploading folders to Filr as described in
“Creating a New Folder” in the Filr : User Access
Guide.

If the browser does not support HTML 5,
uploading both files and folders requires this
version of Java to be installed.
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Table 3-7 Office Application for Edit-in-Place Functionality

NOTE: OpenOffice and LibreOffice are used synonymously throughout the Micro Focus Filr documentation.

For more information about Edit-in-Place, see the Filr : User Access Guide.

Linux + OpenOffice.org (latest version)

*

LibreOffice (latest version)

Windows + LibreOffice (latest version)
+ OpenOffice (latest version)
+ MS Office 2013
+ MS Office 2010
+ MS Office 365

Mac + LibreOffice (latest version)
+ OpenOffice (latest version)
+ MS Office 2011 for MAC
+ MS Office 2013 for MAC
+ MS Office 365 for MAC

File Servers (Backend Storage)

NOTE: Your organization’s file servers provide the backend storage for Net Folders.

If you use Filr only for user personal storage (My Files), then file servers aren’t required.

Table 3-8 File Servers

Platform Supported Versions

Windows + Windows 2008 R2 (CIFS)
+ Windows 2012 R2 (CIFS)

Windows native DFS-N and DFS-R with replication are supported

OES ¢ OES 11 SP1 (NCP and CIFS)

IMPORTANT: You must apply at least the December 2012 Scheduled
Maintenance Update, otherwise the NCP server can fail.

+ OES 11 SP2 (NCP and CIFS)
¢ OES 2015 (NCP and CIFS)
+ OES 2015 NSS AD (CIFS)
DFS and DST for OES are supported.

Domain Services for Windows (DSfW) is not supported.

NetWare + NetWare 6.5.8

SharePoint + 2013

System Requirements

17



Platform Supported Versions

Other In addition to storage that is directly attached to the file servers listed in Net Folders
can provide access to files that are being stored on any of the following storage
methods:

* NetApp NAS device
+ EMC

+ Other Microsoft Active Directory joined NAS devices that support the CIFS
protocol.

+ Storage Area Network (SAN)

Filr Software

You will download and prepare the Filr software in Chapter 5, “Downloading and Preparing the Filr
Software,” on page 27.

IP Addresses

Each appliance requires the following.

Table 3-9 IP Addresses

Component Requirement
IP Address + A static address that is associated with a DNS
host name.

Example: 192.168.1.61

Network Mask + The appropriate network mask for the IP
address.

Example: 255.255.255.0

Gateway IP Address + The gateway for the IP address subnet.

Example: 192.168.1.254

DNS Host Name * The DNS name associated with the IP address.

Example: filr-1.myorg.local

DNS IP Address + Up to three IP addresses of DNS servers for the
IP address subnet.

Example: 192.168.1.1

18 Filr 3.0 Installation, Deployment, and Upgrade Guide



Component

Requirement

NTP IP Address or DNS Name * Up to three IP addresses or DNS names of

reliable NTP servers used to coordinate time on
your organization’s network—especially your
LDAP directory servers.

Example: time.myorg.local

If using VMware, Novell recommends setting up NTP
in accordance with the VMware best practices
guidelines (http://kb.vmware.com/selfservice/
microsites/
search.do?language=en_US&cmd=displayKC&extern
alld=1006427).

LDAP Directory Services (Users and Groups)

Table 3-10 LDAP Directory Services

Directory Service

Platform Version

eDirectory

Active Directory

* NetlQ eDirectory 8.8.x.x (8.8.8.3 is recommended).

For more information, see the NetlQ eDirectory 8.8 Documentation website
(http://www.novell.com/documentation/edir88).

+ NetlQ eDirectory version 8.8.x.x on standalone Windows.

IMPORTANT: eDirectory running on Windows servers with file shares is not
supported.

+ Windows Server 2008 R2 Active Directory with the latest Service Pack

+ Windows Server 2012 R2 Active Directory with the latest Service Pack

For more information, see Windows Server 2008 Active Directory (http://
www.microsoft.com/windowsserver2008/en/us/active-directory.aspx).

Mobile Device Platforms

IMPORTANT: Accessing Filr through a web browser on a mobile device is not supported. Instead,
download the Filr mobile app that is compatible with your mobile device.

For more information about the Filr mobile app, see the Mobile App Quick Start.

System Requirements
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Table 3-11 Mobile Devices

Platform

Supported Versions

iOS Phones and Tablets

* iOS 8.x or later

The native app is available as a free download in
the Apple App Store.

Android Phones and Tablets

+ Android phones and tablets for Android 2.3 or
later

The native app is available as a free download in
the Google Play App Store, the Amazon
Appstore for Android, and the Samsung Knox
Apps store.

Windows Phones

+ Windows 8.0 and 8.1

IMPORTANT: Windows tablets are not currently

supported.

BlackBerry PlayBook and 210

The native application is available in the BlackBerry
World app store.

Filr documentation for BlackBerry is the same as for
Android devices.

SQL Database Server

Table 3-12 SQL Database Server

Database Type Supported Versions

MySQL

*

*

5.6 on Linux

5.6.x on Windows

Microsoft SQL

2008 R2 on Windows 2008 R2
2012 SP2 on Windows 2012 R2
2014 on Windows 2012 R2

MariaDB

SLES 12
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Virtualization Hypervisor Platform

Table 3-13 Virtualization Hypervisor Platform

Hypervisor Type Supported Versions

VMware + One of the following VMware host servers for hosting the appliance VMs.
+ ESXi 6.0 with the latest update
* ESX 5.5 with the latest update
For the most up-to-date compatibility matrix of supported VMware host servers, see

the VMware Compatibility Guide (http://www.vmware.com/resources/compatibility/
search.php?deviceCategory=software&testConfig=16) provided by VMware.

+ A VMware vSphere client 5.1.x or later for accessing the host server and the
appliances for initial configuration.

Not all versions of the vSphere client are compatible with versions of VMware ESX and
ESXi. See the VMware Product Interoperability Matrixes (http://
partnerweb.vmware.com/comp_guide2/sim/interop_matrix.php) provided by VMware.

+ VMware vMotion is supported when running Filr on VMware ESXi or 5.5 with the latest
updates

Hyper-V + The following platforms
+ Windows 2008 R2 Server (as a Role)
* Hyper-V Server 2012 R2 (Core)

+ Hyper-V Manager to deploy, set up, and configure the appliances.

Xen IMPORTANT: Apply all Xen and kernel patches before installing.

+ One of the following servers with the Xen packages installed and the Xen bootloader
running by default.

+ SLES 11 SP4, 64-bit
¢ SLES 12, 64-bit

+ Virtual Machine Manager to deploy, set up, and configure the appliances.

Citrix Xen + Citrix XenServer 6.5 and later

+ Citrix XenCenter to deploy, set up, and configure the appliances.

System Requirements
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Setting Up Shared Storage

IMPORTANT: Filr 3.1 is only available as an online update to Filr 3.0.

+ To Install a New Filr 3.1 Appliance: Install Filr 3.0 using this guide, then follow the instructions

in the Filr 3.1 Release Notes to apply the 3.1 update.

+ See Worksheet 25—Storage Planning Summary
Figure 4-1 is the first in a series of illustrations that visually track deployment order.

Figure 4-1 Export an NFS Directory or Create a CIFS share for the /vashare mount point

Set Up NFS or CIFS Shared Storage

NFS v3 Server CIFS Server
am O" omem (.
i B
- [Ty
Exported Directory
for /vashare on all
Filr appliances

—B-B

download.novell.cor

SQL Server

Filr Search 1

Filr Search 2

Complete the instructions in the section below that applies to the plans you have made on Worksheet

25:

+ “Exporting an NFS Directory for the /vashare Mount Point” on page 23

Or

+ “Creating a CIFS Share for the /vashare Mount Point” on page 25

Exporting an NFS Directory for the /vashare Mount Point

IMPORTANT: Filr does not support remote NFS from a Novell Storage Services (NSS) volume.

Setting Up Shared Storage

23
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If you plan to use a CIFS share for Filr shared storage (/vashare) in Worksheet 25, skip to “Creating a
CIFS Share for the /vashare Mount Point” on page 25. Otherwise, export an NFS directory on a Linux
server by doing the following:

Table 4-1 Task 1: Exporting an NFS Directory for /vashare

Page, Dialog, or Option Do This

1 - Verify that the server has adequate disk space.

1. Make sure that the Linux server that you are targeting has the available disk
space you identified in “Recording Your Plan” in the Filr Planning Your Filr
Deployment—Best Practices guide and recorded on Worksheet 25.
If necessary, add disk space to the Linux server.
1. On the Linux server, launch YaST2.
YaST Control Center 1. Inthe Network Services section, click NFS Server.
The NFS Server Configuration dialog box displays.
NFS Server 1. Make sure that the NFS Server is set to Start, that Open Port in Firewall is
Configuration selected (running firewall required for option), and that Enable NFSv4 is not
selected - i.e. NFS v4 is disabled.
2. Click Next.
Directories to Export 1. Click Add Directory.
YaST2 1. Click Browse and choose the directory or share path identified on Worksheet
25 that has the required disk space.
You can add a directory name, such as / shar ed to the path if desired.
IMPORTANT: The directory path must not be located in the /var directory
structure on the NFS server, as explained in “NFS Mount Point Must Not Point
to /var on Target Server” in the Novell Filr 2.0 Release Notes.
2. Click OK.

As your first Filr appliance is deployed, a directory named f i | r will be created
within the directory path you have specified.

3. If you added to the directory path, click Yes to confirm directory creation.
4. Leave the asterisk (*) in the Host Wild Card field.

5. Click the Options field to edit it and change the following options:

* rotorw/(read-only to read-write)
+ root_squashtono_root_squash.
Click OK.

Directories to Export

Click Finish.
Skip to Chapter 5, “Downloading and Preparing the Filr Software,” on page 27.
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Creating a CIFS Share for the /vashare Mount Point

Table 4-2 Task 1: Creating a CIFS Share for /vashare

Page, Dialog, or Option Do This

1 - Verify that the Windows server has adequate disk space.

1. Make sure that the Windows server that you are targeting has the available
disk space you identified in “Recording Your Plan” in the Filr Planning Your Filr
Deployment—Best Practices guide and recorded on Worksheet 25.
If necessary, add disk space to the server.

2. Open Windows Explorer

Windows Explorer 1. In Windows Explorer, navigate to the folder that you identified on Planning

Worksheet 25.
This folder will be the shared storage location (/vashare) for Filr.

2. Right-click the folder, then click Properties.

folder Properties

1. Click the Sharing tab.

2. Click Share.
Filr Sharing 1. Add a user (new or existing) to the list and assign the Read/Write permission
to the user.
IMPORTANT: You will need the username and password when you select the
CIFS share while deploying the Filr appliances.
2. Click Share > Done > Close.
Directories to Export 1. Continue with Chapter 5, “Downloading and Preparing the Filr Software,” on

page 27.
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Downloading and Preparing the Filr
Software

IMPORTANT: Filr 3.1 is only available as an online update to Filr 3.0.

+ To Install a New Filr 3.1 Appliance: Install Filr 3.0 using this guide, then follow the instructions
in the Filr 3.1 Release Notes to apply the 3.1 update.

After planning your deployment and making sure you have the necessary system requirements in
place, you are ready to download and prepare the Filr software that applies to your virtualization
platform.

Figure 5-1 Download the Filr Software for your VM platform

Download Filr Software

NFS v3 Server CIFS Server

download.novell.com

SQL Server

y
Filr Search 1

}
Filr Search 2

+ “YMWare” on page 28
+ “Hyper-V” on page 28
+ “Xen” on page 29

+ “Citrix Xen” on page 30
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VMWare

1 As planned in Worksheets 21, 22, and 23 download the Filr software shown below to your

management workstation.

IMPORTANT: Registration with Micro Focus is required to receive an email with a download link.

Appliance Type Filename
Filr Filr.x86_64-version.ovf.zip
Search Fi I rsearch. x86_64-version. ovf. zip

MySQL (only if no in-house SQL server is available) MySQ.. x86_64- ver si on. ovf. zi p

Extract each . ovf. zi p file on your management workstation until an Appl i anceType- ver si on
folder appears.

3 Continue with Section 6.1, “Deploying a VMware VM,” on page 32.

Hyper-V

1 Log in to the Hyper-V host server either locally or from a remote workstation using Remote

Desktop.

As planned in Worksheets 21, 22, and 23 download the Filr software shown below to the location
where you plan to host your VMs as identified on Planning Worksheet 25.

IMPORTANT: Registration with Micro Focus is required to receive an email with a download link.

Appliance Type Filename
Filr Filr.x86_64-version.vhd. zip
Search Fi I rsearch. x86_64-version. vhd. zi p

MySQL (only if no in-house SQL server is available) MySQL. x86_64- ver si on. vhd. zi p

Extract each . vhd. zi p file in the directory where you downloaded it until an Appl i anceType-
versi on.vhd archive fil e appears.

As planned in Worksheets 21, 22, and 23, create a new directory for each virtual machine.

As a best practice, name these directories with the name that you plan to use for your different
appliances.

Consider including information in the names that easily identifies the appliance type and other
information, such as the IP address.

For example,
¢ filr-1-30-192.168.1.61
¢ filr-2-30-192.168.1.62
¢ filrsearch-1-30-192.168.1.71
* filrsearch-2-30-192.168.1.72

Move the fil r-versi on. vhd archive file to the first Filr appliance-type folder and then copy the
archive file to the remaining Filr appliance type folders.
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6 Move the fil rsearch-version. vhd archive file to the first Filrsearch appliance-type folder and
then copy the archive file to the second Filrsearch folder.

7 (Optional) If you are deploying a MySQL appliance rather than using an in-house SQL server,
move the nysql - ver si on. vhd archive file to the MySQL appliance folder.

8 Continue with Section 6.2, “Deploying a Hyper-V VM,” on page 35.

Xen

1 Log into the Xen VM host server either locally or from a remote workstation.
If you are connecting from a remote Linux workstation, use the following command:
ssh - X root @ost _i p_address

The -X in the command in required for the GUI installation program upon which the steps in this
section are based.

2 As planned in Worksheets 21, 22, and 23 download the Filr software shown below to the Xen VM
host server in the location where you plan to host your VMs as identified on Planning Worksheet
25.

IMPORTANT: Registration with Micro Focus is required to receive an email with a download link.

Appliance Type Filename
Filr Filr.x86_64-version.xen.tar.gz
Search Fi | rsearch. x86_64-version. xen.tar. gz

MySQL (only if no in-house SQL server is available) MySQ.. x86_64- ver si on. xen. tar. gz

3 Untar each *. gz file in the directory where you downloaded it.
You can use the following command to untar the file:
tar -Sxvzf ApplianceType.x86_64-version.xen.tar.gz
An Appl i anceType- ver si on directory is created for each appliance type.

4 Copy and rename the Appl i anceType directories until you have one directory for each appliance
that you have planned to deploy.

Consider including information in the name that easily identifies the appliance, such as the IP
address. For example:

1. Rename the Fi | r-versi on directory to Fi | r- 30- 192. 168. 1. 61.

2. Copy the Fil r-30-192. 168. 1. 61 directory and rename it to Fi | r- 30- 192. 168. 1. 62, and
so on until you have the Correct number of Filr appliances you identified in Worksheet 21.

3. In a similar manner, copy and rename the Fi | r sear ch- ver si on directory until you have
two Filrsearch appliances.

4. If you need a MySQL appliance, follow the same methodology.

IMPORTANT: Do not change the names of the . rawor . xenconf i g files within the directories
that you have copied and renamed.

5 Continue with Section 6.3, “Deploying a Xen VM,” on page 38.
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Citrix Xen

1 On a workstation with Citrix XenCenter installed, download the Filr software shown below, as
planned in Worksheets 21, 22, and 23.

IMPORTANT: Registration with Micro Focus is required to receive an email with a download link.

Appliance Type Filename
Filr Filr.x86_64-version.xva.tar. gz
Search Fi I rsearch. x86_64-version. xva.tar. gz

MySQL (only if no in-house SQL server is available) MySQL.. x86_64- ver si on. xva. tar. gz

2 Using a program such as 7-Zip, extract each . xva. t ar. gz file on your management workstation
until an Appl i anceType- ver si on folder appears.

3 Continue with Section 6.4, “Deploying a Citrix Xen VM,” on page 41.
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6 Deploying the Virtual Machines

IMPORTANT: Filr 3.1 is only available as an online update to Filr 3.0.

+ To Install a New Filr 3.1 Appliance: Install Filr 3.0 using this guide, then follow the instructions
in the Filr 3.1 Release Notes to apply the 3.1 update.

After downloading and preparing the Filr software as instructed in Chapter 5, “Downloading and
Preparing the Filr Software,” on page 27, complete the instructions in the section for your
virtualization platform.

Figure 6-1 Deploy All VMs

Deploy All the VMs

NFS v3 Server CIFS Server

download.novell.com l

.4
SQL Server

J
Filr Search 1
]
Filr Search 2
9
Filr 1
Filr 2
Filr 3

*

Section 6.1, “Deploying a VMware VM,” on page 32

*

Section 6.2, “Deploying a Hyper-V VM,” on page 35

*

Section 6.3, “Deploying a Xen VM,” on page 38
+ Section 6.4, “Deploying a Citrix Xen VM,” on page 41
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6.1 Deploying a VMware VM

Complete the steps in Table 6-1 for each appliance that you planned in the following worksheets:

+ Worksheet 21—Filr Appliances
+ Worksheet 22—Filrsearch Appliances
+ Worksheet 23—SQL Database (if applicable)

Table 6-1 Deploying a VMware VM

Page, Dialog, or Option Do This

1 - Identifying the appliance.

1. Referring to the worksheets listed in the introduction, choose an appliance to
deploy.

IMPORTANT: Your Filr deployment must be set up in the order specified in
Chapter 8, “Creating an Expandable Filr Deployment,” on page 51.

2 - Launching the vSphere Client, naming the VM, and choosing the
datastore.

vSphere Client 1. On your management workstation, start the vSphere Client.
2. Click File > Deploy OVF Template.

Deploy OVF Template 1. Click Browse.

Open 1. For the appliance type you are deploying, navigate to the contents of the
appropriate folder extracted in Step 2 on page 28.

TIP: Check to be sure that the appliance type matches the worksheet you are
following.

Select the . ovf file.

Click Open.

w N

=

Deploy OVF Template Click Next > Next.

2. Inthe Name field, type the name of the appliance as planned on the worksheet
you are following. For example filr-30-192.168.1.61.

3. Click Next.

4. Choose the datastore you identified as the Location on VM Host Server on
Worksheet 25—Storage Planning Summary.

5. Click Next to accept the default for the disk format.
6. Do not select Power on after deployment.
7. Click Finish.

The boot disk is created and the appliance is deployed as specified to this
point.

3 - Editing the VM settings.

vSphere Client 1. Inthe vSphere Client, right-click the VM you just deployed and select Edit
Settings.

The Virtual Machine Properties dialog displays.
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Page, Dialog, or Option Do This

Virtual Machine
Properties

1.

The Filr VMware VMs ship with Memory and CPU settings that are appliance-
type appropriate in most circumstances.

You can adjust them at this point if desired, or you can adjust them later if
required for performance tuning purposes.

If you increase or decrease server memory for a Filr or Filrsearch appliance,
you should also modify the Java heap size, as described in “Changing JVM
Configuration Settings” in the Filr : Administrative Ul Reference.

4 - Adding and configuring disk 2 (/vastorage)

Virtual Machine 1. Click Add.
Properties
Add Hardware 1. Select Hard Disk.
2. Click Next.
3. Click Next (create a new virtual disk).
4. Adjust the Disk Size field value specified for disk 2 on this appliance in the
Worksheet 25—Storage Planning Summary.
5. Under Disk Provisioning, select either:
* Thick Provision Eager Zeroed
or
¢ Support clustering features such as Fault Tolerance
Depending on the VMware version that you are running.
6. Under Location, select Specify a datastore or Datastore cluster
7. Click Browse.
8. Select a datastore
9. Click OK.
10. Click Next.
11. Under Virtual Device Node section, select SCSI (1:0).
12. Under Mode, select Independent and Persistent.
13. Click Next.
14. Click Finish.

5 - Adding and Configuring disk 3 (/var)

Virtual Machine
Properties

1.

Click Add.
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Page, Dialog, or Option Do This

Add Hardware 1. Select Hard Disk.

2. Click Next.

3. Click Next (create a new virtual disk).
4

. Adjust the Disk Size field value specified for disk 3 on this appliance in the
Worksheet 25—Storage Planning Summary.

5. Under Disk Provisioning, select either:

* Thick Provision Eager Zeroed

or

¢ Support clustering features such as Fault Tolerance
Depending on the VMware version that you are running.
Under Location, select Specify a datastore or Datastore cluster
Click Browse.
Select a datastore
Click OK.
10. Click Next.
11. Under Virtual Device Node section, select SCSI (2:0).
12. Click Next.
13. Click Finish.

14. If you need to add network adapters, continue with 6 - (Optional) Adding a
Network Adapter.

© © N o

Otherwise, click OK, return to the top of Table 6-1, and deploy the next
appliance you have planned for.

6 - (Optional) Adding a Network Adapter

You can add a network adapter if your Filr deployment accesses a separate network
for one or more of the following reasons:

+ Appliance administration.
* NFS mount or CIFS access to the /vashare mount point.
+ Security of memcached.

IMPORTANT: Bonding or teaming NICs is not supported with Filr.

Virtual Machine 1. Click Add.

Properties

Add Hardware 1. Select Ethernet Adapter.
2. Click Next.

3. Under Network Connection, select the secondary network associated with
the Filr installation.

4. Click Next > Finish > OK.

vSphere Client 1. Repeat the steps in this table until all of your planned appliances have been
deployed, then continue with Chapter 7, “Starting and Configuring the
Appliances,” on page 45.
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Deploying a Hyper-V VM
Complete the steps in Table 6-2 for each appliance that you planned in the following worksheets:

+ Worksheet 21—Filr Appliances
+ Worksheet 22—Filrsearch Appliances
+ Worksheet 23—SQL Database (if applicable)

Table 6-2 Deploying a Hyper-V VM

Page, Dialog, or Option Do This

1 - Identifying the appliance.

1. Referring to the worksheets listed in the introduction, choose an
appliance to deploy.

IMPORTANT: Your Filr deployment must be set up in the order
specified in Chapter 8, “Creating an Expandable Filr
Deployment,” on page 51.

2 - Open Hyper-V Manager.

Hyper-V Host Server 1. Open the Hyper-V Manager.

3 - Create a new VM.

Hyper-V Manager 1. Inthe left pane, right-click the server where you have planned to
create the new virtual machine, then click New > Virtual
Machine.

The New Virtual Machine Wizard displays.
2. Click Next.

Specify Name and Location 1. Referring to the appropriate appliance worksheet, specify the
appliance name and select the folder that you created in Step 4
on page 28.

2. Click Next.

Specify Generation 1. Make sure that Generation 1 is selected.
2. Click Next.

4 - Specify memory

Assign Memory 1. Inthe Startup RAM field, specify the amount of memory (in MB)
that you planned on the worksheet for this VM.

2. Click Next.

5 - Assign network adapter

Configure Networking 1. On the Configure Networking page, select the networking card
for this VM.

2. Click Next.

6 - Identify the system disk
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Page, Dialog, or Option

Do This

Connect Virtual Hard Disk

1. Select Use an existing virtual hard disk.

Browse to and select the . vhd file in the folder you created for
this appliance.

3. Click Open.
4. Click Next.

Summary

Click Finish.

The VM is created and appears in the list of Virtual Machines.

7 - Specify processors

Hyper-V Manager

1. In Hyper-V Manager, right-click the VM that you just created.

Click Settings.

Processor

1. Click Processor.

3.

In the Number of virtual processors field, specify the number
of processors that you planned on the worksheet for this VM.

Click Next.

8 - Add hard disk 2 (/vastorage).

Settings for VM on Host Server

1. Under Hardware, select IDE Controller 1
2. Click Hard Drive.

Click Add.
A Hard Drive entry is added below the controller.

Hard Drive 1. Under Media, select Virtual hard disk.
2. Click New.

New Virtual Hard Disk Wizard 1. Click Next.

Choose Disk Format 1. Select VHD.
2. Click Next.

Choose Disk Type

1. On the Choose Disk Type page, select Fixed size

2. Click Next.
Specify Name and Location 1. Specify the following:
+ Name: A descriptive name for the virtual disk. For
example, Fi | r-1-Di sk- 2.
+ Location: Specify the location where you want the virtual
disk to be located.
2. Click Next.
Configure Disk 1. Select Create a new blank virtual hard disk.
2. Size: Specify the amount calculated for disk 2 on this appliance
in the Worksheet 25—Storage Planning Summary.
3. Click Next.

Summary

1. Review the summary information.

2.

Click Finish

9 - Add hard disk 3 (/var).
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Do This

Hyper-V Manager 1. In Hyper-V Manager, right-click the VM that you just created.
2. Click Settings.

Settings for VM on Host Server 1. Under Hardware, select SCSI Controller.
2. Click HardDrive.
3. Click Add.

A Hard Drive entry is added below the controller.

Hard Drive 1. Under Media, select Virtual hard disk.
2. Click New.

New Virtual Hard Disk Wizard 1. Click Next.

Choose Disk Format 1. Select VHD.
2. Click Next.

Choose Disk Type

1. On the Choose Disk Type page, select Fixed size

Click Next.

Specify Name and Location

Specify the following:

+ Name: A descriptive name for the virtual disk. For
example, Fi | r-1- Di sk- 3.

+ Location: Specify the location where you want the virtual
disk to be located.

Click Next.

Configure Disk

1. Select Create a new blank virtual hard disk.

Size: Specify the amount calculated for disk 3 on this appliance
in the Worksheet 25—Storage Planning Summary.

Click Next.

Summary

1. Review the summary information.

2.

Click Finish > OK

10 - (Optional) Add a Network Adapter

You can add a network adapter if your Filr deployment accesses a
separate network for one or more of the following reasons:

*

*

Appliance administration.

NFS mount or CIFS access to the /vashare mount point.

+ Security of memcached.
IMPORTANT: Bonding or teaming NICs is not supported with
Filr.
Hyper-V Manager 1. In Hyper-V Manager, right-click the virtual machine for which
you want to create an additional NIC, then click Settings.
Settings for VM on Host Server 1. Under Hardware, select Add Hardware.

Add Hardware

1. Click Network Adapter.

Click Add.
A Network Adapter entry is added to the hardware list.
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6.3

Page, Dialog, or Option

Do This

Network Adapter

1.

Under Virtual Switch, select the secondary network associated
with the Filr installation.

2. Specify any other required settings for the new network adapter.

Click OK.

Hyper-V Manager

Repeat the steps in this table until all of your planned
appliances have been deployed, then continue with Chapter 7,
“Starting and Configuring the Appliances,” on page 45.

Deploying a Xen VM

Complete the steps in Table 6-3 for each appliance that you planned in the following worksheets:

+ Worksheet 21—Filr Appliances

+ Worksheet 22—Filrsearch Appliances
+ Worksheet 23—SQL Database (if applicable)

Table 6-3 Deploying a Xen VM

Page, Dialog, or Option

Do This

1 - Before you deploy the first Xen VM.

1.

If you have not already done so, before you begin this process,
you must set up shared storage for your Filr appliances by
either:

+ Exporting an NFS directory
or
+ Creating a CIFS share
See the “Network-Based Shared Disk Space for /vashare”

section of Worksheet 25 and complete the instructions in
Section 4, “Setting Up Shared Storage,” on page 23.

2 - ldentifying the appliance.

1.

Referring to the worksheets listed in the introduction, choose an
appliance to deploy.

IMPORTANT: Your Filr deployment must be set up in the order
specified in Chapter 8, “Creating an Expandable Filr
Deployment,” on page 51.

3 - Launch the installer.

Terminal prompt on Xen VM Host
Server

1. Run the following command to launch the GUI configuration

menu:
vminstall

The Create a Virtual Machine wizard is displayed.

Create a Virtual Machine

1. Click Forward.
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Do This

Install an Operating System?

1. Select| have a disk or disk image with an installed
operating system.

2. Click Forward.

Type of Operating System

1. Select SUSE Linux Enterprise Server 11.
2. Click Forward.

4 - Name the VM.

Summary

1. Click Name of Virtual Machine.

Name of Virtual Machine

1. Inthe Name field, type the name of one of the appliances that
you prepared a directory for in Step 4 on page 29.
For example, filr-1-30-192.168.1.61.

2. (Optional) In the Description field, type additional information
about the appliance.

3. Click Apply.

5 - Specify the RAM and Virtual Processors.

Summary 1. Click Hardware.
Hardware 1. Change the Initial Memory and Maximum Memory specify the
amount of memory (in MB) that you planned on the worksheet
for this VM.
2. Change the Virtual Processors setting to the number that you
planned on the worksheet for this VM.
3. Click Apply.
6 - Configure the boot disk
Summary 1. Click Disks.
Disks 1. Click the Harddisk button.
Virtual Disk 1. Click the Browse button.

Locate Disk or Disk Image.

1. Navigate to the contents of the folder for the appliance you are
creating.

2. Select the . r awfile.

3. Click Open.
Virtual Disk 1. Click OK.
7 - Configure disk 2 (/vastorage)
Disks 1. Click the Harddisk button.
Virtual Disk 1. Click the Browse button.

Locate Disk or Disk Image.

1. Selectthe . rawfile.
2. Click Open.
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Page, Dialog, or Option

Do This

Virtual Disk 1. Click in the Source field.

2. Press the End key.

3. Use the Backspace key to erase the filename so that the path
ends with the forward slash (/) that follows the appliance’s folder
name.

4. Type a disk name that reflects the appliance name and that this
is disk 2. For example, Filr-192.168.1.61-disk-2.

5. Do not change the Storage Format.

6. Change the Size field value according to the appliance type as
specified in the Worksheet 25—Storage Planning Summary.

7. Make sure that Create Sparse Image File is selected.

8. Click OK.

8 - Configure disk 3 (/var)
Disks 1. Click the Harddisk button.
Virtual Disk 1. Click the Browse button.
Locate Disk or Disk Image. 1. Select the . r awfile.

2. Click Open.

Virtual Disk 1. Clickin the Source field.

2. Press the End key.

3. Use the Backspace key to erase the filename so that the path
ends with the forward slash (/) that follows the appliance’s folder
name.

4. Type a disk name that reflects the appliance name and that this
is disk 3. For example, Filr-192.168.1.61-disk-3.

5. Do not change the Storage Format.

6. Change the Size field value according to the appliance type as
specified in the Worksheet 25—Storage Planning Summary.

7. Click OK.

Disks 1. Click Apply.

2. If you need to add network adapters, continue with “9 -

(Optional) Add a Network Adapter”.
Otherwise, click OK.

The virtual machine is created, the appliance starts, and the
configuration process begins.

Go to Chapter 7, “Starting and Configuring the Appliances,” on
page 45.

After completing the instructions in Chapter 8, return to Table 6-
3 on page 38 to deploy your next appliance.
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Page, Dialog, or Option

Do This

9 - (Optional) Add a Network Adapter

You can add a network adapter if your Filr deployment accesses a
separate network for one or more of the following reasons:

*

*

*

Appliance administration.
NFS mount or CIFS access to the /vashare mount point.
Security of memcached.

IMPORTANT: Bonding or teaming NICs is not supported with
Filr.

Summary

Click Network Adapters.

Network Adapters

Click New.

Virtual Network Adapter

1. Specify the settings for the adapter.

2. Click Apply.
Network Adapters 1. Click Apply.
Summary 1. Click OK.

The virtual machine is created, the appliance starts, and the
configuration process begins.
Go to “4 - Accept the license and specify the keyboard layout.”

on page 46, then return to Table 6-3 on page 38 to deploy your

next appliance.

Deploying a Citrix Xen VM

Complete the steps in Table 6-4 for each appliance that you planned in the following worksheets:

+ Worksheet 21—Filr Appliances

+ Worksheet 22—Filrsearch Appliances
+ Worksheet 23—SQL Database (if applicable)

Table 6-4 Deploying a Citrix Xen VM

Page, Dialog, or Option Do This

1 - Identify the appliance to deploy.

1. Referring to the worksheets listed in the introduction, choose an appliance to

deploy.

IMPORTANT: Your Filr deployment must be set up in the order specified in
Chapter 8, “Creating an Expandable Filr Deployment,” on page 51.

2 - Launch XenCenter.

Management
Workstation

1. Start XenCenter.
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Page, Dialog, or Option Do This

XenCenter 1.

2.

Connect to the Citrix XenServer where you planned to deploy Filr in Worksheet
23 - VM Host Servers.

Right-click the server and select Import.

3 - Import the system disk

Locate the File you want 1.

to import

Browse to and select the . xva file on your management workstation for the
appliance type that you are deploying.

Click Open.
Click Next.

Select the location where 1.

Select the XenServer.

the imported VM will be 2 Click Next
placed ' '
Select target storage 1. Select the storage repository for the VM.
2. Click Import.
4 - Select the network adapter
Select network to 1. Select the virtual network adapter.
connect VM 2. Click Next.
Review the import 1. Deselect Start VM(s) after import.
settings 2. Click Finish.
IMPORTANT: Depending on network latency and other factors, it can take a
while to import the system disk.
5 - Specify Memory
1. If you need to adjust the memory to the amount of memory that you planned on
the worksheet for this VM, select the newly created VM selected in the left
pane.
2. Click the Memory tab.
3. Click Edit, change the setting, and click OK.
6 - Specify Processors
1. If you need to adjust the CPUs to the number that you planned on the
worksheet for this VM, right-click the newly created VM in the left pane.
2. Select Properties.
3. Click CPU, change the setting, and click OK.
7 - Add Disk 2 (/vastorage)
1. With the newly created VM selected in the left pane, click the Storage tab.
Virtual Disks 1. Click Add....
Add Virtual Disk 1. Type a disk name that reflects the appliance name and that this is disk 2. For
example, Filr-1-disk-2.
2. Change the Size field value according to the appliance type as specified in the
Worksheet 25—Storage Planning Summary.
3. Click Add.

8 - Add Disk 3 (/var)
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Virtual Disks

Click Add....

Add Virtual Disk

3.

Type a disk name that reflects the appliance name and that this is disk 3. For
example, Filr-1-disk-3.

Change the Size field value according to the appliance type as specified in the
Worksheet 25—Storage Planning Summary.

Click Add.

9 - (Optional) Add a Network Adapter

You can add a network adapter if your Filr deployment accesses a separate network
for one or more of the following reasons:

*

*

*

Appliance administration.

NFS mount or CIFS access to the /vashare mount point.

Security of memcached.

IMPORTANT: Bonding or teaming NICs is not supported with Filr.

1. With the newly created VM selected in the left pane, click the Networking tab.

Select the secondary network associated with the Filr installation..

XenCenter

Repeat the steps in this table until all of your planned appliances have been
deployed, then continue with Chapter 7, “Starting and Configuring the
Appliances,” on page 45.
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Starting and Configuring the Appliances

IMPORTANT: Filr 3.1 is only available as an online update to Filr 3.0.

+ To Install a New Filr 3.1 Appliance: Install Filr 3.0 using this guide, then follow the instructions
in the Filr 3.1 Release Notes to apply the 3.1 update.

After the VMs are deployed with the necessary disks added and other settings adjusted according to
your plans, it is time to start and configure the appliance software on each appliance. When this step

is completed, all of the appliances will be running and ready to be deployed as an integrated Filr
infrastructure.

Figure 7-1 Starting and Configuring the Appliances

Start and Configure All the Appliances

NFS v3 Server CIFS Server

download.novell.com
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Filr Search 1
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Table 7-1 Starting and Configuring the Appliances

Page, Dialog, or Option Do This

NOTE: For Xen, after you have completed the instructions in Section 6.3,
“Deploying a Xen VM,” on page 38, skip to “4 - Accept the license and specify the
keyboard layout.” in this table.

1 - Before you deploy the first VM.

1. If you have not already done so, before you begin this process, you must set
up shared storage for your Filr appliances by either:

* Exporting an NFS directory
or
¢ Creating a CIFS share
See the “Network-Based Shared Disk Space for /vashare” section of

Worksheet 25 and complete the instructions in Section 4, “Setting Up Shared
Storage,” on page 23 before continuing.

2 - Select an appliance.

1. Choose one of the appliances that you deployed in Chapter 6, “Deploying the
Virtual Machines,” on page 31 and refer to its planning worksheet as you start
and configure it.

IMPORTANT: You must set up your Filr deployment in the order specified in
Chapter 8, “Creating an Expandable Filr Deployment,” on page 51.

3 - Start the appliance.

1. After you have downloaded the Filr software and configured your appliances,
you must start and configure each appliance in turn.

* VMware: In the vSphere Client, power on the first appliance, then click
the Console tab.

+ Hyper-V: In Hyper-V Manager, right-click the VM and select Start.

+ Citrix Xen: In XenCenter, right-click the appliance and select Start.

4 - Accept the license and specify the keyboard layout.

1. After the appliance boots, the License Agreement screen displays.

License Agreement 1. Select your preferred keyboard layout in the Keyboard Language drop-down.

2. (Optional) use the License Language drop-down to change the license
language.

3. (Optional) use the Keyboard Language drop-down to change the keyboard
layout.

4. Accept the license agreement.
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Page, Dialog, or Option Do This

Passwords and Time
Zone

1. On the configuration page, specify the following information:

IMPORTANT: Keep a confidential record of the passwords you set for the root
and vaadmin users below.

Root password and confirmation: The root password provides root access
to the appliance terminal prompt. Do not access appliances as the root user
unless specifically requested by Filr support personnel.

Vaadmin password and confirmation: The preferred user for accessing the
appliance as requested by Filr support personnel.

Consider using a different password for each appliance for enhanced security.

NTP Server: The IP address or DNS name of the reliable external Network
Time Protocol (NTP) server for your network.

Example: time.example.com.

For the best results, set up NTP in accordance with the VMware best practices
guidelines (http://kb.vmware.com/selfservice/microsites/
search.do?language=en_US&cmd=displayKC&externalld=1006427).

Region: Your local region.

Time Zone: The time zone of all file servers that Filr will provide access to.

. Click Next.

Network Settings

. Specify the following:

Hostname: The fully qualified DNS host name associated with the appliance’s
static IP address.

Example: myFilr.mynetwork.example.com.
IP Address: The static IP address for the appliance.
Example: 172.17.2.3.

Network Mask: The network mask associated with the appliance’s IP
address.

Example: 255.255.255.0.

Gateway: The IP address of the gateway on the subnet where your Filr virtual
appliance is located.

Example: 172.17.2.254.

IMPORTANT: Filr appliances do not tolerate latency and should be installed in
the same subnet or a near-subnet.

DNS Servers: The IP address of a primary DNS server for your network.
Example: 172.17.1.1.

Domain Search: The domain that is associated with the Filr host name.

2. Click Next.

Starting and Configuring the Appliances
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Page, Dialog, or Option Do This

Additional LAN Card 1. (Conditional) If you configured multiple network adapters for this appliance,
Configuration select from the following options, then click Next:

+ Do Not Configure: Select this option to configure this network at a later
time as described in “Changing Network Settings” in the Filr :
Administrative Ul Reference.

+ DHCP Dynamic Address: Select this option to have an IP address
assigned dynamically on the secondary network.

+ Statically Assigned IP Address: Select this option to assign a static IP
address on the secondary network. Then specify the IP address, network
mask, and host name.

Data Store Location 1. Hard Disk 2 is automatically detected and the disk designation is displayed in
the hard drive drop-down.

Accept the defaults for the other options on this page by clicking Next.

WARNING: If you have not already created additional disks 2 and 3 for each of
your VMs and prepared a shared storage location for your Filr appliances as
described in early sections of this guide and in Recording Your Plan in the Filr
Planning Your Filr Deployment—Best Practices guide, power off the virtual
machine and make sure you have the required disk space in place for your
deployment before proceeding. Otherwise, there is a substantial risk that your
deployment will not meet your organization’s needs.

Data Log Location 1. Hard Disk 3 is automatically detected and the disk designation is displayed in
the hard drive drop-down.

Filr: Accept the defaults for the other options on this page by clicking Next.

Filrsearch and MySQL: Accept the defaults for the other options on this page
by clicking Configure.

Shared Storage Type 1. If you are configuring a Filrsearch or MySQL appliance, this page doesn’t
(Filr only) appear. Go to “Configuring Password, Time, and Network Settings” on
page 49.

2. If you are configuring a Filr appliance in an expandable deployment (the
default for this guide)

a. Select the option for the type of shared storage (Remote NFS or Remote
CIFS) that you identified and configured in Chapter 4, “Setting Up Shared
Storage,” on page 23.

b. Click Next and continue with the steps for the page matching your
selection.

3. If you are configuring a small or non-expandable deployment
a. Select Do Not Configure Shared Storage.
b. Click Next.

c. Go to “Configuring Password, Time, and Network Settings” on page 49.
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Page, Dialog, or Option Do This

Shared Storage NFS
Location

Referring to the work you did in “Exporting an NFS Directory for the /vashare Mount
Point” on page 23, do the following:

1.

For the NFS Server Hostname field, click Browse and select the NFS server
that you identified.

For the Remote Directory field, click Browse and select the directory that you
exported.

3. Click Configure.

4.

Go to “Configuring Password, Time, and Network Settings” on page 49.

Shared Storage CIFS
Location

Referring to the work you did in “Creating a CIFS Share for the /vashare Mount
Point” on page 25, do the following:

1. Type the UNC path to the share that you created.

2. Type the user name of the CIFS user that you identified or created.
3.

4. Click Configure.

Type the password of the CIFS user.

Configuring Password,
Time, and Network
Settings

1.

The settings you have specified are configured, storage is verified, and the
appliance starts.

Continue as indicated for your deployment type:

Expandable Deployment: Repeat the above steps starting with “2 - Select an
appliance.” on page 46 until all of your appliances are started, configured, and
running. Then go to Chapter 8, “Creating an Expandable Filr Deployment,” on
page 51.

All-in-one (Small) Deployment: Return to Appendix B, “All-in-One (Small)
Deployment—Creating,” on page 111.

Non-expandable Deployment: Repeat the above steps starting with “2 -
Select an appliance.” on page 46 until all of your appliances are started,
configured, and running. Then return to Appendix E, “Non-Expandable
Deployment—Creating,” on page 129.
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8 Creating an Expandable Filr Deployment

IMPORTANT: Filr 3.1 is only available as an online update to Filr 3.0.

+ To Install a New Filr 3.1 Appliance: Install Filr 3.0 using this guide, then follow the instructions
in the Filr 3.1 Release Notes to apply the 3.1 update.

Figure 8-1 illustrates the general order for deploying Filr components. Letters reference brief
component/process descriptions in the table that follows.

The first process (shared storage) was completed in Chapter 4, “Setting Up Shared Storage,” on
page 23 and illustrated in Figure 4-1 on page 23.

The illustrations that follow are to help you track deployment progress.
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Figure 8-1 Creating an Expandable Deployment
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Letter Details

o Exported NFS Directory or CIFS Share: All of the Filr appliances in an expandable deployment
share this directory, which stores

+ Mutually accessed configuration files
+ Personal storage
+ Temporary files used by upload and conversion processes

+ HTML renderings
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8.1

Letter

Details

Q Filr Software: You download Filr software that you then deploy as a boot/system disk on your VM
host server.

e SQL Database: Each Filr appliance in an expandable deployment accesses the same SQL
database. If available, an SQL server should be used, but if that is not an option, the MySQL
appliance can be deployed in its place.

Q Filrsearch Appliances: Micro Focus best practices require that each Filr cluster be configured with
two Filrsearch appliances.

G Filr Appliances: By definition, a Filr cluster must contain at least two Filr appliances. Micro Focus
recommends three Filr appliances with the third appliance dedicated to Net Folder synchronization
and maintaining the search index.

G Additional Filr Appliances: More Filr appliances can be included as the service load increases.

To create an expandable Filr deployment, complete the following sections in the order presented.

+ Section 8.1, “Setting Up the SQL Database,” on page 53
+ Section 8.2, “Setting Up Two Filr Search Appliances,” on page 56

+ Section 8.3, “Setting Up the Filr Appliances,” on page 58

+ Section 8.4, “Completing the Expandable Filr Deployment,” on page 63

+ Section 8.5, “Dedicating a Filr Appliance to Indexing and Net Folder Synchronization,” on
page 65

+ Section 8.6, “Using the Dedicated Filr Appliance to Complete the Indexing Setup,” on page 66

Setting Up the SQL Database

Figure 8-3 illustrates that an SQL database is the second component deployed (after shared storage)
when creating an expandable Filr deployment.
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53



54

8.1.1

Figure 8-2 Set Up an SQL Database
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IMPORTANT: As noted elsewhere, Micro Focus recommends using an existing SQL database if one
is available.

If you need to use a MySQL appliance, prepare that now by completing the instructions in
Appendix D, “MySQL Appliance—Configuring (Alternate Practice),” on page 127 and then continue
with Section 8.3, “Setting Up the Filr Appliances,” on page 58.

Prepare your in-house SQL server by completing the steps in one of the following sections:

+ Section 8.1.1, “Configuring a MySQL or MariaDB Server,” on page 54
+ Section 8.1.2, “Configuring a Microsoft SQL Server,” on page 55

Configuring a MySQL or MariaDB Server

IMPORTANT: Do not create the Filr database on your MySQL or MariaDB server manually.

Let the Filr configuration wizard create the database to ensure the correct configuration.
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8.1.2

Table 8-1 Configuring MySQL or MariaDB for Filr

File Do This

1 - Edit the configuration file.

MySQL or MariaDB 1. Edit the file as follows:
server >/ et c/ ny. cnf
file [client]

defaul t-character-set = utf8

[nysql d]

character-set-server = utf8
max_connections = 900

transaction-isol ati on = READ- COW TTED
expire_l ogs_days = 7

The expi re_| ogs_days setting is optional, but is recommended because it
cleans up nysql - bi n-* files.

Unless this is done regularly, the files will consume significant disk space in the
vast or age directory.
2. Uncomment the InnoDB tables section.

3. Increase the buffer pool size to approximately 60 percent of the amount of
RAM that has been allocated to the dedicated server.

For example, a dedicated server with 4 GB of RAM should have a buffer pool
size of 2560 MB, as follows:

i nnodb_buf fer_pool _size = 2560M

4. ldentify or create a user account with sufficient rights to create and manage the
Filr database.

Worksheet 23 1. Record the username and password on Worksheet 23.

2. Continue with Section 8.2, “Setting Up Two Filr Search Appliances,” on
page 56.

Configuring a Microsoft SQL Server

IMPORTANT: Do not create the Filr database on your MS SQL server manually.

Let the Filr configuration wizard create the database to ensure the correct configuration.

Table 8-2 Configuring Microsoft SQL Server for Filr

File Do This

1 - Configure the server.
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File Do This

Server management 1. Enable remote access to the Microsoft SQL database server.

console 2. Open port 1433 on the Windows firewall where the database server is running.

3. Identify or create a user account that is configured with SQL Server
Authentication and has sufficient rights to create and manage the Filr
database.

IMPORTANT: Filr supports only SQL Server Authentication. Windows
Authentication and Windows Domain User Authentication to Microsoft SQL are
not supported.

Worksheet 23 1. Record the username and password on Worksheet 23.
Server management 1. Run the following queries against the database:
console

ALTER DATABASE dat abase- nane SET READ_COWM TTED_SNAPSHOT ON
ALTER DATABASE dat abase-name COLLATE Latinl_Ceneral Cl_AS KS W5

2. Continue with Section 8.2, “Setting Up Two Filr Search Appliances,” on
page 56.

8.2 Setting Up Two Filr Search Appliances

Filr best practices require that every expandable deployment have two Filrsearch appliances. There
are no advantages to having more than two.

Best practices allow for operating Filr with one search appliance, but only under special
circumstances, such as when reindexing is required. One appliance continues to service user
requests while the other is focused on rebuilding the search index.

Figure 8-3 shows that two Filr Search appliances are the third and fourth components deployed in an
expandable deployment.
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Figure 8-3 Set up Two Filr Search Appliances
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Table 8-3 Setting Up the Filrsearch Appliances

Page, Dialog, or Option

Do This

1.

Open a management browser on your administrative workstation and access
the Port 9443 Administration Utility on the first Filrsearch appliance using the
following URL:

https://filrsearch_| P_Address: 9443

Where IP_Address is the IP address of the first Filrsearch appliance.

Filr Search Appliance 1. Login as the vaadm n user with the password that you set for the appliance in
Sign In “Vaadmin password and confirmation:” on page 47.
Filr Search Tools m
1. Click the Configuration button # | t0 launch the Filr Search Configuration
Wizard.
Filr Search Configuration 1. Click Next.
Wizard 2. Type and confirm a password for the Lucene Service User (use the same
password for both appliances).
Make a note of the password for later.
3. Click Finish.

Creating an Expandable Filr Deployment

57



58

Page, Dialog, or Option Do This

Search Settings 1. Scroll down and click Submit > OK.

1. Repeat the steps in this table for the second Filrsearch appliance, then close
the browser.

2. Continue with Section 8.3, “Setting Up the Filr Appliances,” on page 58

8.3 Setting Up the Filr Appliances

Figure 8-4 illustrates that the Filr appliances are deployed after all other components are in place.

Figure 8-4 The Filr Appliances Are Set Up Last
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Table 8-4 Logging in and Starting the Configuration Wizard

Page, Dialog, or Option Do This

1. Open a management browser on your administrative workstation and access
the Port 9443 Administration Utility on the first Filr appliance using the
following URL:

https://filr_I P_Address: 9443

Where IP_Address is the IP address of the first Filr appliance.

Filr Appliance Sign In 1. Login as the vaadm n user with the password that you set for the appliance in
“Vaadmin password and confirmation:” on page 47.

Filr Appliance Tools o

1. Click the Configuration icon % | o launch the Filr Configuration Wizard.

Filr Configuration Wizard 1. Large Deployment is automatically selected.

Click Next.

Figure 8-5 Each Filr Appliance Needs the Database Connection Information
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Table 8-5 Configuring each Filr to connect to the SQL Database

Page, Dialog, or Option Do This

Database 1. Specify the following configuration options for the database:

Database Type: Select the type of database that you prepared in Section 8.1,
“Setting Up the SQL Database,” on page 53.

Host Name: The host name or IP address of the database server.

Port: The wizard selects the standard port for the database type. If your server
communicates using a non-standard port, adjust the number accordingly

Database Name: The name of the database you want the wizard to create
(first appliance) and then connect to (subsequent appliances).

User Name: The administrative user name you identified in Section 8.1,
“Setting Up the SQL Database,” on page 53.

For the MySQL appliance, the defaultisfilr.

Password: The administrative user’s password.
2. Click Next.
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Figure 8-6 Initially, Each Filr Appliance Is Configured to Work with One Filr Search Appliance
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Table 8-6 Specify the First Search Appliance, Locale, and Admin user

Page, Dialog, or Option Do This

Search Appliance 1.

Specify the first Filrsearch appliance’s DNS name and Lucene password, then
click Finish.

IMPORTANT: If you specify the IP address, it must be resolvable to the DNS
hostname of the search appliance.

Click Next.

Default Locale 1.

Select a Default Locale.

2. If desired, specify a name other than admi n for appliance administration on

port 8443.
Click Finish.

IMPORTANT: Wait for the appliance to start before closing the tab or
navigating away from the page.

When the “Congratulations!” message displays, return to Table 8-4 and deploy
the next Filr appliance.

Atfter all of the Filr appliances are deployed, continue with “Completing the
Expandable Filr Deployment.”
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8.4 Completing the Expandable Filr Deployment

Figure 8-7 When One Filr Appliance Is Configured for “Filr Clustering,” All of Them Are
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Table 8-7 Enabling Filr-based Clustering

Page, Dialog, or Option Do This

Configuration Summary 1.

In the Configuration panel, click Clustering.

Clustering 1.

Select Enable Clustered Environment.

The JVM Route field is used only if you are setting up Apache load balancing,
and is used to uniquely identify this appliance. In many cases, the hostname
(automatically supplied) will suffice, but you can customize it if needed.

In the Server Address field, make sure that both Filrsearch appliances in your
deployment are listed. Separate the appliances with a space. Use either IP
addresses or fully-qualified hostnames to identify the appliances.

4. Click OK.

5. Click Reconfigure Filr Server.

The Filr appliance is reconfigured and restarted.

Subsequently, the configuration is shared by each Filr appliance through the /
vashar e mount point.

Figure 8-8 The Filr Appliances Are Individually Configured to Use Both Filrsearch Appliances
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Table 8-8 Configuring High-availability Searching

Page, Dialog, or Option Do This

Configuration Summary 1.

In the Configuration panel, click Search Appliance.

Search Appliance 1.

Click the Configuration Type drop-down list and select High Availability.

2. Type the Lucene service password that you set in Table 8-3 on page 57.

3. Notice that the Filrsearch appliance you configured for this Filr appliance is
listed under Name.
Click Add.
New Search Node 1. Inthe Name: field, type an arbitrary name for the second appliance.
2. Inthe Host Name: field, type the DNS host name of the other Filrsearch
appliance.
3. Click OK.
Search Appliance 1. Click OK.
Configuration 1. Click Reconfigure Filr Server.

The appliance is reconfigured and restarted.

However, in contrast with the process in Table 8-7, the Search Appliance
configuration is not propagated to the other Filr appliances.

In the upper-right corner, click Log out.

1. Log in to the next Filr appliance and repeat the steps in this table.

When all of the Filr appliances have been configured for high-availability
searching, continue with Dedicating a Filr Appliance to Indexing and Net
Folder Synchronization.

Dedicating a Filr Appliance to Indexing and Net
Folder Synchronization

As a best practice, Micro Focus recommends dedicating one Filr appliance to Indexing and Net
Folder Synchronization, which are very resource-intensive tasks.

Do the following:

+ Allow Net Folder Synchronization on only the dedicated appliance: Disable Net Folder
Synchronization on all other Filr appliances as follows:

1.
2. Click Net Folders.

3.

4. Repeat on all other Filr appliances except the one you are dedicating to Net Folder

Access the Port 9443 administration console.

De-select Allow Synchronization.

Synchronization.

Now when a Full synchronization occurs (either as a result of a scheduled or manual
synchronization), the Filr appliance that you set aside is the one that handles the load.

NOTE: Just-in-time synchronization (JITS) is unaffected and takes place on whichever Filr
appliance receives the user request that triggers JITS.
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+ Use Load Balancing to isolate the dedicated appliance from user requests: When you set
up load balancing, don’t include the dedicated Filr appliance in the round-robin rotation.

+ Rebuild the search index using the dedicated appliance: Follow the steps in the next

section.

Thereafter, the dedicated appliance will handle all of the re-indexing workload.

8.6 Using the Dedicated Filr Appliance to Complete
the Indexing Setup

Table 8-9 Index with the Dedicated Appliance

Page, Dialog, or Option Do This

1.

Open a management browser on your administrative workstation and access
the Port 8443 Administration Utility on the Dedicated Filr Appliance using the
following URL:

https://dedicated_filr_|P_Address: 8443

Where IP_Address is the IP address of the dedicated Filr appliance.

Filr 3.0 Sign In Dialog

Log in as user adm n with password adni n, or with the alternate administrator
name/password if you specified one for this appliance in Table 8-6 on page 62.

2. When prompted, change the user password.
Product Improvement 1. Click OK.
(first login only)
Filr Main Window (Web 1. Click the Admin user name in the upper-right corner.

access)

Select Administration Console.

Administration Console

Click Index in the left frame.

Search Index

Select Re-Index Everything.

Under Select the Nodes to Apply Re-Indexing to, select the second, write-
only Filrsearch appliance.

Click OK.

Indexing should complete with no errors.

Indexing has finished!

Click Close.

Administration Console

Click Nodes in the left frame.

Search Nodes

Change the User Mode Access option for the second Filrsearch appliance to
Read and Write.

Click Apply > Close.

the dedicated Filr appliance will now handle all of the re-indexing workload.
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Setting Up Filr Services

IMPORTANT: Filr 3.1 is only available as an online update to Filr 3.0.

+ To Install a New Filr 3.1 Appliance: Install Filr 3.0 using this guide, then follow the instructions
in the Filr 3.1 Release Notes to apply the 3.1 update.

Complete the following steps to prepare your Filr site and make it available to users.

1 Using the Port 9443 > License dialog, install the same valid license on each Filr appliance in

your system.

2 Referring to the Worksheets indicated below, change any Filr infrastructure configuration

settings that require restarting Filr.

This prevents interrupting Filr services after users begin accessing Filr services.

Worksheet 13 - Notifications

. (Optional) Using the Port 9443 > Configuration >

Outbound E-mail dialog, configure your system for
integration with an external email system.

. Using the Port 8443 > System > E-Mall dialog, review the

default notification settings and make any required
configuration changes.

Worksheet 20 - Networking Support

. Review the settings in the Port 9443 > Firewall dialog and

make sure that the port and firewall settings on your
network are configured to support Filr services.

. If you are enabling port redirection so that users don’t

need to include :8443 in Filr requests, configure that now.

Path: Port 9443 Appliance Console > Configuration >
Network

. If you are using NetlQ Access Manager.

Path: Port 9443 Appliance Console > Configuration >
Reverse Proxy

3 Referring to the worksheets below, add users and groups to your Filr site and set up the LDAP

synchronization processes.

Setting Up Filr Services
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Worksheet 4 - Users and Groups (LDAP 1. Configure your Filr system to connect to an existing
and Non) LDAP source, such as eDirectory or Active Directory, to
control user access to the system.

Path: Port 8443 Filr Admin Console > System > LDAP

2. Manually create any non-LDAP users and groups that
need access to Filr services.

For more information, see “Filr Admin Created Users and
Groups:” in Filr : Understanding How Filr Works and “the
New User button” in the Filr : Administrative Ul
Reference.

Worksheet 5 - LDAP Synchronization 1. Configure the Filr system to synchronize with your LDAP
servers.

For assistance, see “LDAP Servers and Synchronization
in the Filr : Administrative Ul Reference.

If you want users to be able to share through Filr, you must enable sharing for the Filr system.

Worksheet 14 - System-Level Sharing 1. Configure the system-level share settings.

Settings For more information about allowing users to share

documents within Filr, see “Managing Sharing, License
Terms, and Comments” in the Filr : Administrative Ul
Reference.

if you want users to be able to upload personal files and folders directly to the Filr site, you must
enable personal storage.

Worksheet 11 - Personal Storage 1. Configure Personal Storage.

For more information about allowing users to share
documents within Filr, see “Enabling Personal Storage for
Users and Groups” in the Filr : Administrative Ul
Reference.

For more information about personal storage, as well as how personal storage relates to users’
Home folders, see “Enabling Personal Storage for Users and Groups” in the Filr : Administrative
Ul Reference.

Configure Home Net Folder servers.

Worksheet 8 - Net Folder Servers 1. Configure Home Net Folder servers.

For more information, see “Creating and Managing Net
Folder Servers” in the Filr : Administrative Ul Reference.

If the search context of your LDAP synchronization contains an OES or Windows server that has
a Home folder attribute associated with at least one user, a Net Folder Server is ready to be
configured immediately after running the LDAP synchronization process. You need to consider
the amount of data in users’ Home folder directories when performing an LDAP synchronization.
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The following points are critical to successful Home NF Server creation and the synchronization
of access privileges.

+ Import Both Groups and Users: If you import only LDAP users and not the groups they
belong to, then file system group permissions won't map to Filr group permissions when Net
Folders are created.

+ Register User Profiles Automatically (default): If you deselect this option, then users
won't be created until after they log in. This causes the following issues:

+ You must wait until users log in to their home folders before you can configure the
proxy users and passwords for any HOME Net Folder Servers.

+ Net Folder access permissions that key off user-based file system permissions will not
be set or updated during Net Folder Synchronizations.

+ Register Group Profiles Automatically (default): If you deselect this option, groups will
not be created and Net Folder access permissions that key off group-based file system
permissions will not be set or updated during Net Folder Synchronizations.

7 Configure Net Folder Servers.

Worksheet 8 - Net Folder Servers 1. Configure the other Net Folder servers that are identified

on the worksheet.
Worksheet 10 - Home Folder Net Folder ) ) ) )
Servers For more information, see “Creating and Managing Net

Folder Servers” in the Filr : Administrative Ul Reference.
Worksheet 17 - Net Folder Server
Synchronization

8 Configure Net Folders.

Worksheet 9 - Net Folders 1. Configure the Net Folders that are identified on the

] worksheet.
Worksheet 15 - Net Folder Sharing . . o . Y
Settings For more information, see “Managing Net Folders” in the

Filr : Administrative Ul Reference.
Worksheet 16 - Net Folder Global
Settings

Worksheet 18 - Net Folder
Synchronization

Net Folders in Filr provide access to files on your corporate OES, Windows, or NetWare file
servers by synchronizing file metadata. In essence, a Net Folder is simply a pointer or a
reference to a specific folder on a specific file server.

Filr can be configured to index the content of Net Folders to make the content searchable.

For more information about Net Folders, see “Managing Net Folders” the Filr : Administrative Ul
Reference.

9 Enable additional Filr Users for Administrative Access.

Worksheet 19 - Administrative Access 1. Configure users for administrative access to Filr.

For more information, see “Assigning and Managing Port
8443 Direct Administrators” in the Filr : Administrative Ul
Reference.

10 (Optional) Allow access to the Filr site through NetlQ Access Manager.
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11

12

13

14

15

For more information about using NetlQ Access Manager with Filr, see Chapter A, “Access
Manager (NAM) and Filr Integration,” on page 103.

IMPORTANT: When you use NetlQ Access Manager with Filr, external users cannot access
your Filr site. This means that the following features are not functional:

+ Users are not able to share with external users, as described in “Sharing with People
Outside Your Organization” in the Filr : User Access Guide.

+ Users cannot make items accessible to the public, as described in “Making Files Accessible
to the Public” in the Filr : User Access Guide.

This means that public users cannot access the Filr site as the Guest user. For more
information about the Guest user, see “Guest Users:” in Filr : Understanding How Filr
Works.

For more information about external users in Filr, see “External, Self-Provisioned Users:” in Filr :
Understanding How Filr Works.

Configure mobile device access to the Filr site, as described in “Mobile Device Access—Default
Settings” in the Filr : Administrative Ul Reference.

Configure the Filr desktop application to access files from the Filr site.

For more information about configuring the Filr desktop application, see “Desktop Access—
Default Settings” in the Filr : Administrative Ul Reference.

IMPORTANT: For optimal performance of the Filr system when using the Filr desktop
application, consider the following:

+ Users should not configure the Filr desktop application to synchronize more than 1,000 total
files, or to synchronize individual files that are larger than 1 GB to their workstations. For
information about how users can configure the Filr desktop application to synchronize files
to their workstations, see the Micro Focus Filr 3.0 Desktop Application Guide for Windows
(https://www.novell.com/documentation/filr-3/filr-desktop/data/bookinfo.html) and the Micro
Focus Filr 3.0 Desktop Application Guide for Mac (https://www.novell.com/documentation/
filr-3/filr-desktop-mac/data/bookinfo.html).

Configure Filr to support WebDAV on a Windows 7 environment, as described in “WebDAV
Support on Windows 7” in the Filr : Maintenance Best Practices Guide.

If your Filr site needs to support multiple languages, configure the site as described in “Ul
Language” in the Filr : Administrative Ul Reference.

After you have completed all of the topics in this list that are relevant to your Filr environment,
you can invite users to use the Filr site. For information about how to use the Filr site, see Filr :
User Access Guide.

Filr 3.0 Installation, Deployment, and Upgrade Guide


https://www.novell.com/documentation/filr-3/filr-desktop/data/bookinfo.html
https://www.novell.com/documentation/filr-3/filr-desktop-mac/data/bookinfo.html
https://www.novell.com/documentation/filr-3/filr-desktop-mac/data/bookinfo.html

10.1

10.1.1

Setting Up Sharing

IMPORTANT: Filr 3.1 is only available as an online update to Filr 3.0.

+ To Install a New Filr 3.1 Appliance: Install Filr 3.0 using this guide, then follow the instructions
in the Filr 3.1 Release Notes to apply the 3.1 update.

Before users can share, they must have sharing enabled for them at the Filr system level, either
individually or as a member of a group.

After that, sharing of My Files is enabled by default, but sharing in Net Folders requires additional
steps.

Use the following sections as a guide through the process of setting up sharing.

+ Section 10.1, “Enabling Users to Share,” on page 71

*

Section 10.2, “Do Not Enable Sharing for All Internal Users and All External Users,” on page 76

*

Section 10.3, “System-Level Sharing Must Be Configured First,” on page 77

*

Section 10.4, “My Files Sharing Is Automatic,” on page 77

*

Section 10.5, “Net Folder Sharing Must Be Explicitly Allowed At Two Levels,” on page 78

Enabling Users to Share

+ Section 10.1.1, “Best Practices for Setting Up Sharing,” on page 71
¢ Section 10.1.2, “General Order for Setting Up Sharing,” on page 72
+ Section 10.1.3, “Enabling Sharing for Specific Net Folders,” on page 76

Best Practices for Setting Up Sharing

+ Enable Sharing for the Filr System: You must enable the sharing feature before any sharing
can take place on the Filr system.

As a best practice, enable sharing in an unrestricted way for those users and groups that will be
allowed to share.

+ If Needed, Restrict My Files Sharing: Enabling sharing automatically lets all users share files
in their My Files area, including in their Home folder and in personal storage.

You can restrict My Files sharing on a per-user basis if desired.

+ Carefully Restrict Net Folder Sharing: Net Folder sharing must be explicitly allowed for each
Net Folder.

IMPORTANT: Make sure that only those who need to share a Net Folder’s contents are granted
sharing rights on that Net Folder.

For example, Group A is granted rights to share files in Net Folder A. User A (a member of
Group A) then shares a file with User B (a member of Group B). Because the file contains
sensitive information, User A doesn’t grant User B permission to reshare the file.
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As long as User B doesn’t have rights to share files in Net Folder A, there is no problem.

However, if Group B also has permission to share Net Folder A's files, then User B can reshare
the file even though User A assumed otherwise.

10.1.2 General Order for Setting Up Sharing

72

When you set up sharing for your Filr site, complete the necessary steps in the following order:

1 Set up sharing for the entire Filr site (as described in “Enabling Sharing in Filr" on page 72).

2 Configure sharing for individual users (as described in “Restricting Personal Storage Sharing” on
page 75).

After you have enabled sharing for the entire Filr system, you can fine-tune share rights
throughout the site on the user level.

For example, if you want only a few groups of users to be allowed to share with external users,
you first need to enable sharing to external users at the site level. After you have enabled it at
the site level, you can then remove this ability from the users who you do not want to have this
ability.

3 Set up sharing for specific Net Folders (as described in Section 10.1.3, “Enabling Sharing for
Specific Net Folders,” on page 76).

Users who are given share rights on a specific Net Folder are able to share files within that Net
Folder that they have rights to at least view on the file system.

Enabling Sharing in Filr

After you set up sharing for the entire Filr site, all users by default are granted rights to share files in
the My Files area (this includes files in the Home folder and files in personal storage), with the site-
wide access rights that you specify. If you want only certain users to be allowed to share files from
their My Files area, you must enable sharing for the entire site as described in this section. Then you
must restrict sharing privileges at the user level, as described in “Restricting Personal Storage
Sharing” on page 75.
1 Log in to the Filr site as the Filr administrator.
la Launch a web browser.
1b Specify one of the following URLS, depending on whether you are using a secure SSL
connection:

http://Filr_hostnane: 8080
https://Filr_host nane: 8443

Replace Fi | r _host name with the hostname or fully qualified domain name of the Filr server
that you have set up in DNS.

Depending on how you have configured your Filr system, you might not be required to enter
the port number in the URL. If you are using NetlQ Access Manager, the Filr login screen is
not used.

2 Click the admin link in the upper-right corner of the page, then click the Administration Console
icon 't .

3 Under System, click Share Settings.
The Share Settings page is displayed.
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Righits Whitalist f Blacklist

#| Allow =il users to share with groups that have been imparted from LOAP
Hect a user or group 1o add 1o the list and then grant share righls

Usar or Group

Mo one has been selected

4 Select Allow all users to share with groups that have been imported from LDAP to enable
users to share with LDAP groups.

If you select this option, groups that were imported from the LDAP directory are displayed in the
Share with field when users are sharing an item (as described in “Sharing Files and Folders” in
the Filr : User Access Guide). All users in the LDAP group then have access to the item that was
shared.

Enabling Users and Groups for Net Folder Sharing

1 To enable sharing for all internal users on the Filr site, go to the User or Group field, begin typing
Al Internal Users,then select it when it appears in the drop-down list.

or

To enable sharing on a per-user or per-group basis, go to the Select user/group field, begin
typing the name of the user or group for whom you want to grant share rights, then select the
name when it appears in the drop-down list.

The Edit Share Rights dialog box is displayed. Select from the following options:

Re-share items: When users share a file or folder, they can give the users they are sharing with
the ability to re-share the file or folder. The user receiving the share can share the file only if that
user has been given administrative rights to share the file or folder.

IMPORTANT: When selecting this option, be aware that if one user's access rights to an item
are removed, it does not remove the access rights of the user with whom the item was re-shared.

For example, suppose User A shares an item with User B and grants re-share rights. User B
then shares the item with User C. If User A revokes User B's access rights to the item, User C
continues to have access to the shared item.

Share with Internal users: Allows users to share items with internal users.

Share with “All Internal Users” group: Allows users to perform a mass share to all internal
users by sharing with the All I nternal Users group.

Share with External users: Allows users to share items with users external to the organization.

Users external to the organization receive an email notification with a link to the shared item, and
they can then log in to the Filr site. For more information, see “Sharing with People Outside Your
Organization” in the Filr : User Access Guide.

Share with Public: Allows users to make items publicly available. This means that anyone with
the correct URL to the shared item can access the shared item without logging in to the Filr site.
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In addition to selecting this option, you also need to enable Guest access to the Filr site if you
want to allow users to share items with the public. For information about how to enable Guest
access to the Filr site, see

Share using File Link: Allows users to share a link to a file in Filr. Any user with the link can
then access the file. However, the file is not displayed in the Public area, so users must have
direct access to the link in order to access the file.

For more information about File Links, see “Distributing a Link to a File” in the Filr : User Access
Guide.

(Optional) Click the Whitelist / Blacklist tab to configure which email addresses and domains
users can share with when sharing externally.

Share Setting

Rights | WWhitelist / Blacklist

SpeCity emall addresses and domains that may (whitelist) or
may not (blacklist) be shared with as exiernal shares

Mode

* Nao restrictions - Lisis are ignored
Whitellst - Emall addresses and domains that may be shared with
Blacklist - Email addresses and domains that may not be shared with

Email addresses

Domains

Deleie shares that don't meet the criteria

The following options are available when configuring a whitelist or blacklist for sharing:

No restrictions: Select this option to disregard any email addresses or domains that might
already exist in the Email addresses and Domains fields. Selecting this option means that users
can share with any email address.

Whitelist: Select this option to allow sharing only with email addresses and domains that have
been specified in the Email addresses and Domains fields.

Blacklist: Select this option to disallow sharing with any email addresses and domains that have
been specified in the Email addresses and Domains fields.

Email addresses: Click Add, specify the email address that you want to add to the whitelist or
blacklist, then click OK.

Repeat this process to add multiple email address.

Domains: Click Add, specify the domain that you want to add to the whitelist or blacklist (for
example, yahoo. con), then click OK.

Repeat this process to add multiple domains.
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Delete shares that don’t meet the criteria: Select this option to delete all existing shares in the
Filr system that do not match the criteria you set.

For example, if you selected Blacklist and then specified yahoo.com in the Domains field,
selecting this option would delete all Filr shares made to Yahoo email addresses.

3 Click OK.

Restricting Personal Storage Sharing

After you have enabled sharing of files for the entire Filr system (as described in “Enabling Sharing in
Filr" on page 72), you can restrict shared-access right granting on an individual-user basis.

You cannot grant individual users more rights than are currently defined for the site-wide setting.
To restrict share rights for specific users:

1 Log in to the Filr site as the Filr administrator.
la Launch a web browser.
1b Specify one of the following URLS, depending on whether you are using a secure SSL
connection:

http://Filr_hostnane: 8080
https://Filr_host nane: 8443

Replace Fi | r _host name with the hostname or fully qualified domain name of the Filr server
that you have set up in DNS.

Depending on how you have configured your Filr system, you might not be required to enter
the port number in the URL. If you are using NetlQ Access Manager, the Filr login screen is
not used.

2 Click the admin link in the upper-right corner of the page, then click the Administration Console
icon *'
3 Under Management, click Users.

4 Select the users whose sharing rights you want to manage, then click More > Workspace Share
Rights.
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10.1.3

10.2

k|
Set User Workspace Sharing Rights (1 users)

Allow Sharing with Allow Clear
Internal Users .
External Users .
Public .
Filr Link .

Allow Clear

Allow Re-Sharing of
granted rights

L]

5 Select the radio button in the Clear column next to the sharing right that you want to remove from
the user or group, then click OK.

or

If you have already removed a share right and you want to add it again, select the radio button in
the Allow column next to the sharing right that you want to add to the user or group, then click
OK.

Enabling Sharing for Specific Net Folders

1 Ensure that you have configured sharing as described in “Enabling Sharing in Filr” on page 72.
2 Configure sharing for the Net Folder as described in).

Do Not Enable Sharing for All Internal Users and
All External Users

Prior to the release of Filr 2.0, the documentation stated that enabling sharing for Al | | nt er nal
Users and Al 1 External Users was an acceptable method of enabling sharing on the system.

Unfortunately, this shortcut results in significant system overhead and often leads to serious
performance degradation.

We strongly recommend that you enabling sharing only for specific users and/or groups, as outlined
in the sections that follow.
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10.3 System-Level Sharing Must Be Configured First

The first step in allowing Filr sharing to take place is to list the users and groups who are allowed to
share in the Share Settings dialog. When you add the user or group, you also specify the upper limits

of possible sharing rights for them. You can further restrict the rights, but you can’t expand them

beyond this limit.

Figure 10-1 Setting Up System-Level Sharing Rights

1. Click Share Settings.

Share Settings

1 Whitelist / Blacklis

Sekecl @ user or group (o

— User or Group

No one has been selected

| Allow all users to share with groups that have been imported from LDAP

add to the list and then grant share rights

2.Begin typing, then select | g4 Growa
a user or group.

3. Select the highest
level of rights that the
user or group will need in
Filr, then click OK.

Grant Share Rights
Recipients will be granted share rights to:
Re-share items

Share with Internal users

Share with External users
Share with the Public
Share using File Link

10.4 My Files Sharing Is Automatic

After sharing is enabled at the system level for users individually or as members of groups, then if

those users have personal storage enabled, they can share their files and folders within the

limitations set for the system.

Administrators can disable sharing of files and folders in My Files on an individual user basis.
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Figure 10-2 My Files Share Settings

Share Settings 7]

Rights Whitelist / Blacklist

[¥] Allow all users to share with groups that have been imparted from LDAP

Select a user or group to add to the list and then grant share rights

User or Group: |

Hame Rights

7 P Al Internal Users  Internal / External / Share with all Internal users / Share File Link -

W

Re-Sharing Internal

System-level share settings ——~ determine My Files settings. " » @ J

@ d W

Guest File External
Users Link Users

10.5 Net Folder Sharing Must Be Explicitly Allowed At
Two Levels

Before the users or groups listed in the Share Settings dialog can share files and folders in their
assigned Net Folders, they must have sharing enabled on those Net Folders.

When enabling Net Folder access for a user or group, a Filr administrator can only assign up to the
maximum sharing rights that are set at the system level.

In Figure 10-3, user red can only be assigned sharing rights that are allowed at the system level.
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Figure 10-3 An Example of Net Folder Sharing

Share Settings

Rights | Whitelist/ Blacklist ~ Extemal Users Licensing Terms

¥l Allow all users to share with groups that have been imported from LDAP

Select a user or group to add to the list and then grant share rights.

User or Group: \

Name Rights Type
redapple  Intemal / External / Share File Link =  User @

.

’System—level share settings’ limit the sharing rights .
that can be granted

\to a Net Folder user.,

IManage Net Folders

£ Net Folder: training-ces 7] I

g Confiy Grant Rights
@ Defing Grant recipient rights for this Net Folder.

** Note ** You must set the appropriate rights in the Share Settings
Userg dialog in order for the recipient to perform share eperations

= Hame Allaw access to the Net Folder Granted

] redaj | Recipient can share files in this Net Folder with:

@ Elrﬂema\ users Granted

= E External users Granted
[ Public Not available

[} Share using File Link Available, but not granted
) Allow the recipient to grant files re-share privilege — Not available
Recipient can share folders in this Net Folder with:

Elmema\ users Granted
) Extemnal users Available, but not granted
O Public Not available
[ Allow the recipient to grant folders re-share privilege —Not available
Guest Users File Link Re-Sharing Internal
(Public) Users

Files & Folders [ | (Ml

I

User redapple

Files Only [l | @]

External
Users
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1 Upgrading a Large Filr Deployment

IMPORTANT: Filr 3.1 is only available as an online update to Filr 3.0.

+ To Upgrade to Filr 3.1: Use the instructions in the Filr 3.1 Release Notes to apply the 3.1

update.

Before You Upgrade!

Failure to comply with the following critical points could result in a non-functional Filr system.

NOTE: As an additional resource to the information in this section, TID 7017288 has a “Pre-Flight
Checklist” that can help you ensure a successful upgrade.

Critical Point Details
+ Review the Release * Check “Upgrade” in the Filr 3 Release Notes before you start the upgrade
Notes process.

+ Plan the upgrade order * You must upgrade the appliances in order of dependency upon each other.

and follow it.

1. Shut Down Order: Prepare a list of your appliances that defines the

correct shut down order:

*

*

*

Filr: All Filr appliances must be shut down first.
Filrsearch: Next, you shut down the Filrsearch appliances.

MySQL (if applicable): Finally, if you are using a MySQL
appliance instead of an in-house SQL server, you shut it down
last.

2. Deployment Order: Prepare a second list of that defines the correct
upgrade and deployment order:

*

MySQL (if applicable): If you are using a MySQL appliance
instead of an in-house SQL server, you must upgrade and
deploy that appliance first.

Filrsearch: You must upgrade and deploy the Filrsearch
appliances before the Filr appliances.

Filr: When the upgraded MySQL and Filrsearch appliances are
up and running, upgrade and deploy the first Filr appliance.
Then upgrade and deploy the additional Filr appliances.

3. Ifthere are things you need to remember about individual appliances,
include those reminders in the appropriate list.

4. Use the shut down list as you complete the steps in “Upgrading the
VMs.”

5. Use the upgrade list as you complete the steps in “Deploying the
Upgraded (Replacement) VMs.”

Upgrading a Large Filr Deployment
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Critical Point

Details

¢ Ensure that the VM

host has enough

unformatted disk space.

*

The VM host server must have enough unallocated disk space to contain
the following disks for each appliance. This is only temporary because after
the upgrade completes, old appliances can be deleted and their disk space
reclaimed.

+ System Disk (/): This is created automatically as you deploy the
downloaded software.

Size is 20 GB per appliance.

+ Disk 2 (/vastorage): You make a copy of each old appliance’s Disk
2.

Size needed equals the total size of all disks to be copied.

+ Each Disk 3 (/var): You create this disk for each appliance in
conjunction with the upgrade process.

Size recommendation for Filr 3 is 4 GB plus 3 times the RAM
allocation for each appliance being upgraded.

NOTE: The existing / vashar e mount point is used by the upgraded Filr
appliances. No new disk space is required for upgrading.

Make sure that existing
appliances are running
version 2.0.

Make sure that all appliances are running version 2.0 with the latest
patches applied.

See “Managing Field Test Patches” in the Filr 2.0: Administration Guide.
Version 1.2 appliances must first be upgraded to version 2.0.

See “Upgrading Filr” in the Filr 2.0: Installation and Configuration Guide.

Remove all VMware
Snapshots

Before copying Disk 2, make sure to remove all VMware snapshots so that
the / vast or age disk has the correct disk file and latest configuration
settings.

Make sure that
upgraded appliances
meet Filr 3.0 system
requirements.

See Chapter 3, “System Requirements,” on page 13.

RAM and CPU requirements are summarized in the following sections of
the Planning Best Practices guide:

* Filr Appliance Sizing Guidelines
* Filrsearch Appliance Sizing Guidelines

¢ SQL Server Sizing Guidelines

Do not attempt
unsupported path
migrations.

No Cross-platform: You cannot upgrade from one virtualization platform
to another. You can only upgrade VMware to VMware, and so forth.

No Mixed Versions: All of the Filr and Filrsearch appliances in an
expandable deployment must be upgraded to the same version.

No Cross-Deployment-Types: You can only upgrade small to small, non-
expandable to non-expandable, or expandable to expandable.

If you have a small or non-expandable deployment, and you need an
expandable deployment, you must either install a new system or contact
Micro Focus Consulting (http://www.novell.com/consulting) to assist you
with the migration.
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11.1

Critical Point Details

*

Prepare appliances * For any appliances with two network adapters, do the following:
with two network 1
adapters before

upgrading.

. Download the net wor kpr ep. zi p file from the Filr software
downloads page.

2. Enable SSH on the appliance, as described in “Managing System
Services” in the Filr : Administrative Ul Reference.

3. Using an SSH client (such as WinSCP), log in to the appliance as the
root user.

4. Copy the net wor kpr ep. zi p file that you downloaded to the / r oot /
directory on the appliance.

5. Unzip the net wor kpr ep. zi p file:
unzi p networkprep. zip
The net wor kpr ep folder is created.
6. Change to the net wor k prep folder:
cd /root/networkprep
7. Run the script:
sh run-networ kprep. sh

8. Close the remote SSH connection to the appliance.

*

Plan when to upgrade. + Filr services must be offline during the upgrade.

1. Schedule the upgrade for a block of time that is least disruptive from
a production standpoint.

2. Notify Filr users about the upgrade.

After ensuring that you have met the prerequisites and cautions above, complete the instructions in
the following sections in order.

*

*

Section 11.1, “Understanding the Appliance Upgrade Process,” on page 83
Section 11.2, “Downloading and Preparing Software for the Upgrades,” on page 84
Section 11.3, “Copying Each Appliance’s /vastorage Disk (Disk 2),” on page 87
Section 11.4, “Upgrading the VMs,” on page 88

Section 11.5, “Deploying the Upgraded (Replacement) VMs,” on page 97

Section 11.6, “Performing Post-Upgrade Tasks,” on page 98

Understanding the Appliance Upgrade Process

The process of upgrading Micro Focus appliances is illustrated in Figure 11-1 on page 84.

NOTE: Upgrade processes are unchanged from Filr 2.0. If you performed upgrades to Filr 2.0, you
might find the graphical overview in Figure 11-1 has all the information that you need to proceed.

On the other hand, if you are unsure about any part of the upgrade process, the sections that follow

the graphic should provide the guidance you need.
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Figure 11-1 Overview of the Appliance Upgrade Process

Upgrading an Appliance
0 Download a new version of the Filr,

O—@@
Filrsearch, (and if needed MySQL) 4 I

appliances for your virtualization download. noveII com
platform.

G Deploy the appropriate file to the new
appliance location for each appliance
you are upgrading.

This creates a new VM with a
system disk (/) (Disk 1)
New Appliance 1

eCopy Disk 2 of the existing
appliance being upgraded.

Note: For Citrix Xen, you “export” Location

rather than copylng/@
' /v(%sltsokr azg;e /vastorage New / New /var
g (Disk 2) (Disk 1) (Disk 3)

Existing Appliance 1

0 Start and configure the newly deployed VM with: @ <j-
- Disks: (new /var disk, existing /vashare disk) -
- The correct RAM, ' Existing /vashare

- A second network adapter if needed, NFlzslor ?IFS
ron
and so on. New Appliance 1 (F Y)

G The appliance system prompts you to confirm that you are upgrading.
After you supply a couple of passwords, the system runs through the
configuration screens automatically and the new appliance is an “upgraded”
version of the old appliance.

Important: The order in which you start the appliances during an upgrade is critical.
If you have a MySQL appliance, it must be started first, then the two search
appliances, and finally the Filr appliances.

11.2 Downloading and Preparing Software for the
Upgrades

Download and prepare the software for your virtualization platform as described in the following
sections:

VMWare

1 Download the Filr software shown below to your management workstation.

IMPORTANT: Registration with Micro Focus is required to receive an email with a software-
download link.
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Appliance Type Filename

Filr Filr.x86_64-version.ovf.zip
Search Fi I rsearch. x86_64-version. ovf. zip

MySQL (only if no in-house SQL server is available) MySQ.. x86_64- ver si on. ovf. zi p

2 Extract each . ovf. zi p file on your management workstation until an Appl i anceType- versi on
folder appears.

3 Launch the vSphere Client and navigate to the datastore where you plan to host the upgraded
VMs.

4 Create a folder for each appliance that you plan to upgrade.

Name each folder with a name that is easily associated with (but not the same as) the VM name
of the associated appliance being upgraded.

Consider including information in the names that easily identifies the appliance type and other
information, such as the IP address.

For example,
¢ v3-filr-1-30-192. 168. 1. 61
¢ v3-filr-2-30-192. 168. 1. 62
¢ v3-filrsearch-1-30-192.168.1.71
¢ v3-filrsearch-2-30-192.168.1.72
5 Continue with Section 11.3, “Copying Each Appliance’s /vastorage Disk (Disk 2),” on page 87.

Hyper-V
1 Log in to the Hyper-V host server either locally or from a remote workstation using Remote
Desktop.

2 Download the Filr software shown below to the location where you plan to host your upgraded
VMs.

IMPORTANT: Registration with Micro Focus is required to receive an email with a software-
download link.

Appliance Type Filename
Filr Filr.x86_64-version.vhd. zip
Search Fi I rsearch. x86_64-version. vhd. zi p

MySQL (only if no in-house SQL server is available) MySQL. x86_64- ver si on. vhd. zi p

3 Extract each . vhd. zi p file in the directory where you downloaded it until an Appl i anceType-
version.vhd archive fil e appears.

4 Create a new directory for each virtual machine you are upgrading.

As a best practice, name these directories with names that are easily associated with, but not the
same as the VM name of each appliance being upgraded.

Consider including information in the names that easily identifies the appliance type and other
information, such as the IP address.
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For example,
¢ v3-filr-1-30-192. 168. 1. 61
¢ v3-filr-2-30-192. 168. 1. 62
¢ v3-filrsearch-1-30-192.168.1.71
¢ v3-filrsearch-2-30-192.168.1.72

5 Move the filr-version. vhd archive file to the first Filr appliance-type folder and then copy the
file to the remaining Filr appliance type folders.

6 Move the fil rsearch-version. vhd archive file to the first Filrsearch appliance-type folder and
then copy the file to the second Filrsearch folder.

7 (Optional) If you are deploying a MySQL appliance rather than using an in-house SQL server,
move the nysqgl - ver si on. vhd archive file to the MySQL appliance folder.

8 Continue with Section 11.3, “Copying Each Appliance’s /vastorage Disk (Disk 2),” on page 87.

Xen

1 Log into the Xen VM host server either locally or from a remote workstation.
If you are connecting from a remote Linux workstation, use the following command:
ssh - X root @ost _i p_address

The -X in the command in required for the GUI installation program upon which the steps in this
section are based.

2 Download the Filr software shown below to the Xen VM host server in the location where you
plan to host your upgraded VMs.

IMPORTANT: Registration with Micro Focus is required to receive an email with a download link.

Appliance Type Filename
Filr Filr.x86_64-version.xen.tar.gz
Search Fi I rsearch. x86_64-version. xen.tar. gz

MySQL (only if no in-house SQL server is available) MySQL.. x86_64- ver si on. xen. tar. gz

3 Untar each *. gz file in the directory where you downloaded it.
You can use the following command to untar the file:
tar -Sxvzf ApplianceType.x86_64-version.xen.tar.gz
An Appl i anceType- ver si on directory is created for each appliance type.

4 Copy and rename the Appl i anceType- ver si on directories until you have one directory for each
appliance that you are upgrading.

Also, consider including information in the directory names that easily identifies the appliance
type and other information, such as the IP address.

For example,
¢ filr-1-30-192.168.1.61
¢ filr-2-30-192.168. 1. 62
¢ filrsearch-1-30-192.168.1.71
+ filrsearch-2-30-192.168.1.72
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11.3

IMPORTANT: Only change the directory names.

Do not change the names of the . rawor . xenconf i g files within the directories that you have
copied and renamed.

For example:
1. Rename the Fil r-versi on directory to filr-1-30-192. 168. 1. 61.

2. Copythefilr-1-30-192. 168. 1. 61 directory and renameittofilr-1-30-192. 168. 1. 62,
and so on until you have a directory for each appliance you are upgrading.

3. In a similar manner, copy and rename the Fi | r sear ch- ver si on directory until you have
two Filrsearch appliances.

4. If you need a MySQL appliance, follow the same methodology.
5 Continue with Section 11.3, “Copying Each Appliance’s /vastorage Disk (Disk 2),” on page 87.

Citrix Xen

1 On a workstation with Citrix XenCenter installed, download the Filr software shown below.

IMPORTANT: Registration with Micro Focus is required to receive an email with a download link.

Appliance Type Filename
Filr Filr.x86_64-version.xva.tar. gz
Search Fi I rsearch. x86_64-version. xva.tar. gz

MySQL (only if no in-house SQL server is available) MySQL.. x86_64- ver si on. xva. tar. gz

2 Using a program such as 7-Zip, extract each . xva. t ar. gz file on your management workstation
until an Appl i anceType- ver si on folder appears.

3 Continue with Section 11.3, “Copying Each Appliance’s /vastorage Disk (Disk 2),” on page 87.

C)opying Each Appliance’s /vastorage Disk (Disk
2

IMPORTANT

+ VMware requires shutting down an appliance before copying a disk.
This doesn’'t mean that the entire service must be down while disk copying takes place.

If you have a Filr-clustered deployment, you can minimize service interruption by shutting down
one Filr or Filrsearch appliance, copying the disk, restarting the appliance and continuing with
the next appliance.

+ On Citrix Xen you “export” rather than copying Disk 2.

Copying each appliance’s disk is at the heart of the upgrade process because it uses the
corresponding “old” appliance’s configuration settings on Disk 2 to create an upgraded version of the
appliance with minimal input on your part.

Disk copying can take a while, depending on disk size and the VM host environment.
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Therefore, we recommend keeping service downtime to a minimum by making the copies while the
Filr system is still running.

1 Using the tools provided by your hypervisor, copy the /vastorage (second disk) to its associated
folder or directory that you created for your upgraded appliances in Section 11.2, “Downloading
and Preparing Software for the Upgrades,” on page 84.

11.4 Upgrading the VMs

+ Section 11.4.1, “Shutting Down the Appliances,” on page 88
¢ Section 11.4.2, “Upgrading VMware VMs,” on page 88

*

Section 11.4.3, “Upgrading Hyper-V VMs,” on page 91

*

Section 11.4.4, “Upgrading and Deploying Xen VMs,” on page 92

*

Section 11.4.5, “Upgrading Citrix Xen VMs,” on page 96

11.4.1  Shutting Down the Appliances

1 Shut down all of your existing appliances in the shut down order that you identified earlier:
2 Continue with the instructions for your VM platform:

+ VMware

+ Hypter-V

+ Xen

+ Citrix Xen
11.4.2 Upgrading VMware VMs
Complete the steps in Table 11-1 for each appliance that you are upgrading

Table 11-1 Upgrading a VMware VM

Page, Dialog, or Option Do This

1 - Launching the vSphere Client.

1. On your management workstation, start the vSphere Client.

vSphere Client 2 - Deploying the OVF Template and naming the VM.

1. Click File > Deploy OVF Template.

Deploy OVF Template 1. Click Browse.

Open 1. For the appliance type you are deploying, navigate to the contents of the folder
that you downloaded and extracted in Section 11.2, “Downloading and
Preparing Software for the Upgrades,” on page 84.

2. Select and open the. ovf file.
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Page, Dialog, or Option Do This

Deploy OVF Template 1. Name the appliance with the same name of the folder that you created for this
upgraded appliance in Step 4 on page 85.

Click Next.

Choose the datastore and folder were you copied the appliance’s Disk 2.
Click Next to accept the default for the disk format.

Do not select Power on after deployment.

Click Finish.

The boot disk is created and the appliance is deployed as specified to this
point.

L O

3 - Editing the VM settings.

vSphere Client 1. Inthe vSphere Client, right-click the VM you just deployed and select Edit
Settings.

The Virtual Machine Properties dialog displays.

Virtual Machine 1. Setthe Memory and CPU settings to match the appliance you are replacing,
Properties or increase them as planned.

4 - Configuring disk 2 (/vastorage)

Virtual Machine 1. Click Add.
Properties
Add Hardware 1. Select Hard Disk, click Next and select Use an existing Virtual disk.

2. Click Next > Browse, then navigate to and select the copy of disk 2 that you
made for this appliance.

3. Click Next > Next > Finish.

5 - Adding and Configuring disk 3 (/var)

Virtual Machine 1. Click Add.
Properties
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Page, Dialog, or Option Do This

Add Hardware

1. Select Hard Disk.

Click Next > Next.

3. Adjust the Disk Size to the same size as disk 3 (/var) on the appliance you are

© © N o O

10.
11.
12.
13.

replacing.
Under Disk Provisioning, select either:

¢ Thick Provision Eager Zeroed

or

¢ Support clustering features such as Fault Tolerance
Depending on the VMware version that you are running.
Under Location, select Specify a datastore or Datastore cluster
Click Browse.
Select the datastore and folder for this appliance.
Click OK.
Click Next.
Under the Virtual Device Node section, select SCSI (2:0).
Click Next.
Click Finish.

If you need to add network adapters, continue with 6 - (Optional) Adding a
Network Adapter.

Otherwise, click OK, return to “2 - Deploying the OVF Template and naming
the VM.” on page 88, and deploy the next appliance that you have planned for

When all of your planned appliances have been deployed, continue with
Section 11.5, “Deploying the Upgraded (Replacement) VMs,” on page 97.

6 - (Optional) Adding a Network Adapter

You can add a network adapter if your Filr deployment accesses a separate network
for one or more of the following reasons:

*

*

*

Appliance administration.

NFS mount or CIFS access to the /vashare mount point.

Security of memcached.

IMPORTANT: Bonding or teaming NICs is not supported with Filr.

Virtual Machine 1.
Properties

Click Add.

Add Hardware

1. Select Ethernet Adapter.

2. Click Next.
3. Under Network Connection, select the secondary network associated with

the Filr installation.
Click Next > Finish > OK.

vSphere Client 1.

Repeat the steps in this table from 2 - Deploying OVF Template until all of your
planned appliances have been deployed, then continue with Section 11.5,
“Deploying the Upgraded (Replacement) VMs,” on page 97.
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11.4.3

Upgrading Hyper-V VMs

Complete the steps in Table 11-2 for each appliance that you are upgrading.

Table 11-2 Upgrading a Hyper-V VM

Page, Dialog, or Option

Do This

1 - Open Hyper-V Manager.

Hyper-V Host Server

1. Open the Hyper-V Manager.

2 - Create a new VM.

Hyper-V Manager

1. Inthe left pane, right-click the server where you have planned to
create the new virtual machine, then click New > Virtual
Machine.

The New Virtual Machine Wizard displays.

2. Click Next.

Specify Name and Location

1. Name the appliance with the name of the directory that you
created for it in Step 4 on page 85.

2. Click Next.

Specify Generation

1. Make sure that Generation 1 is selected.
2. Click Next.

3 - Specify memory

Assign Memory

1. Inthe Startup RAM field, specify the same amount of memory
(in MB) of the appliance that you are replacing, or increase the
memory as planned.

2. Click Next.

4 - Assign network adapter

Configure Networking

1. On the Configure Networking page, select the networking card
for this VM.

2. Click Next.

6 - Identify the system disk

Connect Virtual Hard Disk

1. Select Use an existing virtual hard disk.

2. Browse to and select the . vhd file in the folder you created for
this appliance.

3. Click Open.
4. Click Next.

Summary

1. Click Finish.

The VM is created and appears in the list of Virtual Machines.

7 - Specify processors

Hyper-V Manager

1. In Hyper-V Manager, right-click the VM that you just created.
2. Click Settings.

Upgrading a Large Filr Deployment 91



11.4.4

Page, Dialog, or Option

Do This

Processor

1. Click Processor.

2. Inthe Number of virtual processors field, specify the number
of processors for this VM.

3. Click Next.

8 - Use existing copy of hard disk 2 (/vastorage).

Settings for VM on Host Server

1. Add the copy you made of disk 2 to this VM.

2. When you have added the disk, review the VM summary
information and click Finish.

9 - Add hard disk 3 (/var).

Hyper-V Manager

1. In Hyper-V Manager, right-click the VM that you just created.
2. Click Settings.

3. Create a new blank virtual disk the same size as disk 3 on the
appliance you are upgrading.

Summary

1. Review the summary information.
2. Click Finish > OK

10 - (Optional) Add a Network Adapter

1. If the appliance you are upgrading has a secondary network
adapter, add that now.

Hyper-V Manager

11 - Repeat until all VMs have upgraded copies

1. Repeat the steps in this table until all of your planned
appliances have been deployed, then continue with
Section 11.5, “Deploying the Upgraded (Replacement) VMs,” on
page 97.

Upgrading and Deploying Xen VMs

IMPORTANT: Unlike the other virtualization platforms, which you power on and deploy separately
from the upgrade process, upgraded Xen VMs power on automatically when the upgrade process
completes. You must then deploy the appliance before continuing with the next one.

Therefore, it is critical that you make sure to follow the deployment order that you identified earlier.

Complete the steps in Table 11-3 for each appliance that you are upgrading and deploying.

Table 11-3 Upgrading and Deploying a Xen VM

Page, Dialog, or Option

Do This

1 - Launch the installer.
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Page, Dialog, or Option

Do This

Terminal prompt on Xen VM Host
Server

1. Run the following command to launch the GUI configuration
menu:

vminstall

The Create a Virtual Machine wizard is displayed.

Create a Virtual Machine

1. Click Forward.

Install an Operating System?

1. Select| have a disk or disk image with an installed
operating system.

2. Click Forward.

Type of Operating System

1. Select SUSE Linux Enterprise Server 11.
2. Click Forward.

2 - Name the VM.

Summary

1. Click Name of Virtual Machine.

Name of Virtual Machine

1. Inthe Name field, type the name of the appliance.

Use the name of the corresponding directory that you prepared

for the appliance in Step 4 on page 86.

2. (Optional) In the Description field, type additional information

about the appliance.
3. Click Apply.

3 - Specify the RAM and Virtual Processors.

Summary 1. Click Hardware.

Hardware 1. Change the Initial Memory and Maximum Memory set the
amount of memory (in MB) to match that of the VM you are
upgrading.

2. Change the Virtual Processors setting to match the number of
the VM you are upgrading.
3. Click Apply.
4 - Configure the boot disk

Summary 1. Click Disks.

Disks 1. Click the Harddisk button.

Virtual Disk 1. Click the Browse button.

Locate Disk or Disk Image.

1. Navigate to the contents of the folder for the appliance you are

creating.

2. Select the . rawfile.

3. Click Open.
Virtual Disk 1. Click OK.
5 - Configure disk 2 (/vastorage)
Disks 1. Click the Harddisk button.
Virtual Disk 1. Click the Browse button.
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Page, Dialog, or Option

Do This

Locate Disk or Disk Image.

1.
2.

Select the . r awfile for Disk 2.
Click Open.

Virtual Disk

A

Click in the Source field.
Press the End key.

Use the Backspace key to erase the filename so that the path
ends with the forward slash (/) that follows the appliance’s folder
name.

4. Type a name of the copy of disk 2 for this appliance.
5. When you finish linking to the disk, click OK.

6 - Configure disk 3 (/var)

Disks

1.

Click the Harddisk button.

Virtual Disk

1.

Click the Browse button.

Locate Disk or Disk Image.

1. Select the . rawfile.

2. Click Open.

Virtual Disk 1. Click in the Source field.

2. Press the End key.

3. Use the Backspace key to erase the filename so that the path
ends with the forward slash (/) that follows the appliance’s folder
name.

4. Type a disk name that reflects the appliance name and that this
is disk 3. For example, Filr-192.168.1.61-disk-3.

5. Do not change the Storage Format.

6. Change the Size field value to match the size of disk 3 in the
appliance you are upgrading.

7. Click OK.

Disks 1. Click Apply.

2. If you need to add network adapters, continue with “7 -

(Optional) Add a Network Adapter.”
Otherwise, click OK and continue with “8 - Deploy the
Appliance.”
7 - (Optional) Add a Network Adapter
You can add a network adapter if your Filr deployment accesses a
separate network for one or more of the following reasons:

¢ Appliance administration.

* NFS mount or CIFS access to the /vashare mount point.

¢ Security of memcached.

IMPORTANT: Bonding or teaming NICs is not supported with
Filr.

Summary 1. Click Network Adapters.

Network Adapters 1. Click New.
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Page, Dialog, or Option

Do This

Virtual Network Adapter

1. Specify the settings for the adapter.

2. Click Apply.
Network Adapters 1. Click Apply.
Summary 1. Click OK.
The virtual machine is created, the appliance starts, and the
configuration process begins.
Console 8 - Deploy the Appliance

1. Access the appliance’s console.

2. When prompted, enter the root and vaadmin passwords for the
appliance being replaced.

The upgrade process proceeds automatically.

3. When the appliance displays the final screen in the console
window, open your management browser and log in to the
appliance on port 9443 as the vaadmin user.

Port 9443 Admin Console

1. Depending on the appliance type you are upgrading, check the
following:

+ MySQL (optional) :

1. Click the phpMyAdmin icon.

2. Verify that the database is populated as expected.
+ Filrsearch:

1. Click the Filrsearch configuration icon.

2. Ensure that all of the settings are in place as
expected.

3. If the configuration wizard displays, there was a
problem with the configuration.

4. Resolve the configuration issues, then click Finish to
reconfigure the system.

1. Click the Filr configuration icon.

2. Ensure that all of the settings are in place as
expected.

3. If the configuration wizard displays, there was a
problem with the configuration.

4. Resolve the configuration issues, then click Finish to
reconfigure the system.

Common configuration issues include:

+ If your system is not using DNS, the most likely
problem is unresolvable DNS names and
missing /etc/hosts entries.

+ If the appliance doesn’'t have access to the
database, ensure that all of the settings are as
expected.
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Page, Dialog, or Option Do This

11 - Upgrade the Next Appliance

1. Return to the top of the table and repeat the process for the next
appliance in your list.

When all of your appliances are running, continue with
“Performing Post-Upgrade Tasks.”

11.45 Upgrading Citrix Xen VMs

Table 11-4 Upgrading a Citrix Xen VM

Page, Dialog, or Option Do This

1 - Launch XenCenter.

Management 1. Start XenCenter.

Workstation

XenCenter 1. Connect to the Citrix XenServer where you are deploy the upgraded
appliances.

2. Right-click the server and select Import.

2 - Import the system disk

Locate the File you want 1. Browse to and select the . xva file on your management workstation for the
to import appliance that you are upgrading.

2. Click Open.
3. Click Next.

Select the location where 1. Select the XenServer.

the imported VM will be 2 Click Next
placed ' '
Select target storage 1. Select the storage repository for the VM.
2. Click Import.
3 - Select the network adapter
Select network to 1. Select the virtual network adapter.
connect VM 2. Click Next.
Review the import 1. Deselect Start VM(s) after import.
settings 2. Click Finish.

IMPORTANT: Depending on network latency and other factors, it can take a
while to import the system disk.

4 - Specify Memory

1. If you need to adjust the memory to the amount of memory, select the newly
created VM in the left pane.

2. Click the Memory tab.
3. Click Edit, change the setting, and click OK.
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Page, Dialog, or Option Do This

5 - Specify Processors

1. If you need to adjust the CPUs, right-click the newly created VM in the left
pane.

2. Select Properties.
3. Click CPU, change the setting, and click OK.

6 - Link to Disk 2 (/vastorage)

1. With the newly created VM selected in the left pane, add the copy of disk 2 for
this appliance.

8 - Add Disk 3 (/var)

Virtual Disks 1. Click Add....

Add Virtual Disk 1. Type a disk name that reflects the appliance name and that this is disk 3. For
example, Filr-1-disk-3.

2. Change the Size field value to match that of the appliance you are replacing.
3. Click Add.

9 - (Optional) Add a Network Adapter

You can add a network adapter if your Filr deployment accesses a separate network
for one or more of the following reasons:

+ Appliance administration.
* NFS mount or CIFS access to the /vashare mount point.
+ Security of memcached.
IMPORTANT: Bonding or teaming NICs is not supported with Filr.

1. With the newly created VM selected in the left pane, click the Networking tab.
2. Select the secondary network associated with the Filr installation..

XenCenter 1. Repeat the steps in this table until all of your planned appliances have been
upgraded, then continue with Section 11.5, “Deploying the Upgraded
(Replacement) VMs,” on page 97.

11.5 Deploying the Upgraded (Replacement) VMs

IMPORTANT
+ Make sure that you deploy (Start and configure) your appliances one at a time.

Attempting to start and configure multiple upgraded appliances at the same time causes timing,
synchronization, and other problems.

+ Also make sure that you deploy the appliances in the deployment order that you identified
earlier:

1. MySQL (if applicable)
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2. Filrsearch
3. Filr

2 Access the appliance’s console.

The upgrade process proceeds automatically.

1 Power on the first (or next) appliance in your deployment order list.

3 When prompted, enter the root and vaadmin passwords for the appliance being replaced.

When the appliance displays the final screen in the console window, open your management
browser and log in to the appliance on port 9443 as the vaadmin user.

Depending on the appliance type you are upgrading, check the following:

MySQL (optional)

Filrsearch

Filr

1. Click the phpMyAdmin icon.
2. Verify that the database is

populated as expected.

1. Click the Filrsearch
configuration icon.

2. Ensure that all of the
settings are in place as
expected.

3. If the configuration wizard
displays, there was a
problem with the
configuration.

Resolve the configuration
issues, then click Finish to
reconfigure the system.

1.

Click the Filr configuration
icon.

Ensure that all of the
settings are in place as
expected.

If the configuration wizard
displays, there was a
problem with the
configuration.

Resolve the configuration
issues, then click Finish to
reconfigure the system.

Common configuration issues
include:

+ If your system is not using
DNS, the most likely
problem is unresolvable
DNS names and missing /
et ¢/ host s entries.

+ Ifthe appliance doesn't have
access to the database,
ensure that all of the settings
are as expected.

6 When the appliance is running, deploy the next appliance.
7 When all of your appliances are running, continue with “Performing Post-Upgrade Tasks.”

11.6 Performing Post-Upgrade Tasks

After upgrading to a new version of Filr, you should perform the following tasks to ensure a fully
functional Filr system:

+ Section 11.6.1, “(Optional) Enable Net Folder Sharing,” on page 99

+ Section 11.6.2, “Re-Enabling SSH on the Filr Search and Database Appliances,” on page 99
+ Section 11.6.3, “Reset Non-Standard MySQL Ports,” on page 99

¢ Section 11.6.4, “Install Your New Filr License,” on page 99
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11.6.1

11.6.2

11.6.3

11.6.4

(Optional) Enable Net Folder Sharing

Folder sharing is a new feature in Filr 3.0 with an Advanced-Edition license installed.

If you have Net Folders where you want users to be able to share folders as well as files, you must
grant folder sharing rights using the Recipient can share folders in this Net Folder with: option as
documented in “Grant Rights dialog” in the Filr : Administrative Ul Reference.

Re-Enabling SSH on the Filr Search and Database
Appliances

If you enabled SSH on the search or database appliances before upgrading your Filr system, it is

disabled after upgrading, and you need to re-enable it. For more information about how to enable
SSH, see “Managing System Services” in the Filr : Administrative Ul Reference.

Reset Non-Standard MySQL Ports

If you are using a MySQL appliance and have set non-standard MySQL port settings, you must reset
the port for each Filr appliance using the Port 9443 administration utility.

Install Your New Filr License

Upgraded Filr appliances have a 60-day evaluation license installed.

To prevent a service interruption, you must install your new license by following the instructions in
“Installing/Updating the Filr License” in the Filr : Administrative Ul Reference.
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A.l

Access Manager (NAM) and Filr
Integration

You can configure NetlQ Access Manager (NAM) to act as Proxy service for a Filr site. This helps you
provide the ease of single sign-on and establish a trusted relationship with the Access Gateway.
Using Micro Focus Filr in conjunction with NetlQ Access Manager adds enterprise-level security to
your Filr system.

NOTE: Guest users cannot access Filr through NAM.

Review the following sections:

+ Section A.1, “Overview,” on page 103
+ Section A.2, “Configuring Filr Ports,” on page 104

+ Section A.3, “Downloading and Installing the Filr Authentication Plugin (Applicable for Filr 3.1),”
on page 104

+ Section A.4, “Configuring the NAM Identity Server,” on page 105

+ Section A.5, “Configuring a Reverse-Proxy Single Sign-On Service for Micro Focus Filr,” on
page 107

Overview

To integrate Filr with NAM, you must configure the NetlQ Access Manager Identity Server, the Access
Gateway, and configure protected resources for a Micro Focus Filr server.

¢ Section A.1.1, “Filr 3.0 and NAM,” on page 104
¢ Section A.1.2, “Filr 3.1 and NAM,” on page 104
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All

A.l1.2

A.2

A.3

Filr 3.0 and NAM

The integration of Filr 3.0 with NAM allows only LDAP users to log in to Filr through NAM. Non-LDAP
(local, external, guest) users cannot access Filr through NAM. A possible work-around for the
external users to authenticate through NAM is documented in TID 7014912 (https://www.novell.com/
support/kb/doc.php?id=7014912).

Users cannot access the View File Link and Download File Link when Filr 3.0 is integrated with NAM.
For information about distributing a link (URL) to a file, see “Distributing a Link to a File” in the Filr :
User Access Guide.

You use predefined NAM classes, methods, and contracts to integrate Filr 3.0 with NAM. Filr 3.0
requires Access Manager 4.1.1 or later. For information about NetlQ Access Manager, see the
Access Manager Documentation website.

Filr 3.1 and NAM

The integration of Filr 3.1 with NAM allows both LDAP and non-LDAP (local and external) users to log
in to Filr through NAM. However, guest users cannot access Filr 3.1 through NAM.

To integrate Filr 3.1 with NAM for non-LDAP users, you must create new classes, methods, and

contracts in NAM. For LDAP users, you can either use the predefined NAM classes, methods, and
contracts, or create new ones. If you have both LDAP and non-LDAP users, then you can create a
new class, method, and contract to support the authentication for both LDAP and non-LDAP users.

Filr 3.1 introduces a new authentication plugin to enable both LDAP and non-LDAP (local and
external) users to log in to Filr through NAM. To download and install the authentication plugin, see
Section A.3, “Downloading and Installing the Filr Authentication Plugin (Applicable for Filr 3.1),” on
page 104.

Filr 3.1 requires Access Manager 4.2 or later. For information about NetlQ Access Manager, see the
Access Manager Documentation website.

Configuring Filr Ports

Use the following port configuration when NetlQ Access Manager is fronting your Filr system:

¢ HTTP Port: 80
+ Secure HTTP Port: 443

You must configure the port on the Reverse Proxy and Network page of the Port 9443 Appliance
Console. For more information, see “Reverse Proxy Configuration Settings” and “Network
Configuration” in the Filr : Administrative Ul Reference.

Downloading and Installing the Filr Authentication
Plugin (Applicable for Filr 3.1)

To enable Filr 3.1 users to access the Filr services through NetlQ Access Manager (NAM), Filr
provides an authentication plugin that you must download and install on the NAM server that you
want to use as a proxy server.
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To download and install the plugin:
1 Open a browser on your administrative workstation and access the Port 9443 Appliance Console
on the first Filr appliance using the following URL:
https://Filr_IP_Address: 9443
Where Filr_IP_Address is the IP address of the Filr appliance.

2 Click the Configuration and then click Reverse Proxy.

3 In the NetlQ Access Manager Integration section, click Filr Plugin for NAM to download the
Fil r Aut hd ass. j ar file.

4 Copy the Fi | r Aut hd ass. j ar file to the following locations on the NAM server:

¢ Linux: /opt/novel I/ nids/Ilib/webapp/ VEB-INF/1ib

+ Windows: C \Program Files (x86)\Novel |\ Tontat\ webapps\ ni dp\ WVEB- | NF\ cl asses
5 Run the following commands to restart the Identity Server and the Access Gateway:

¢ |dentity Server: /etc/init.d/ novell-idp restart

+ Access Gateway: /etc/init.d/ novell-mag restart

A.4 Configuring the NAM Identity Server

+ Section A.4.1, “Configuring the Identity User Store,” on page 105
+ Section A.4.2, “Creating the Authentication Class,” on page 105

+ Section A.4.3, “Creating the Authentication Method,” on page 106
+ Section A.4.4, “Creating the Authentication Contract,” on page 106

A.4.1 Configuring the Identity User Store

Configure an identity user store to which the Filr users should authenticate. See “Configuring ldentity
User Stores” in the NetlQ Access Manager Administration Guide.

A.4.2 Creating the Authentication Class

Authentication classes let you define ways of obtaining end-user credentials. Depending on whether
you are using Filr 3.0 or Filr 3.1, do one of the following:
¢ For Filr 3.0: Use the Secur e Nane/ Password - For mclass that is predefined in NAM.
+ For Filr 3.1: Perform the following steps to create a class:
1. Log in to the NAM Administration Console.
2. Click Devices > Identity Server > Servers > Edit > Local > Classes.
3. Click New to launch the Create Authentication Class wizard, then fill in the following fields:
+ Display name: Specify a name for the class.
+ Java class: Select Other.
+ Java class path: Specify com novel | . nam aut henti cati on. Fi | r Aut hd ass.
4. Click Next and then click New to add the following properties for the class:
+ Property Name: Specify Fi | r W6 URL.
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+ Property Value: Specify the HTTP or HTTPS URL of the Filr server in the format:
http(s)://1P_Address_of Filr_Server:port_nunber.

5. Continue with Creating the Authentication Method.

A.4.3 Creating the Authentication Method

Authentication methods let you associate authentication classes with user stores.

1 Log in to the NAM Administration Console.
2 click Devices > Identity Server > Servers > Edit > Local > Methods.
3 Click New to launch the Create Authentication Method wizard, then fill in the following fields:
+ Display name: Specify a name for the method.
+ Class: Specify the name of the class:
+ For Filr 3.0: Specify Secure Nanme/ Password - Form

+ For Filr 3.1: Specify the name of the class that you created in Creating the
Authentication Class.

+ Identifies User: Ensure that this option is selected.

+ User stores: Add user stores to search. You can select from the list of all the user stores
you have set up. If you have several user stores, the system searches through them based
on the order specified here. If a user store is not moved to the User stores list, users in that
user store cannot use this method for authentication.

4 Continue with Creating the Authentication Contract.

A.4.4 Creating the Authentication Contract

Authentication contracts define how authentication occurs. Create a new contract with the
authentication method you created in Creating the Authentication Method. Depending on whether you
are using Filr 3.0 or Filr 3.1, do one of the following:
¢ For Filr 3.0: Use the Secur e Nane/ Password - For mcontract that is predefined in NAM.
+ For Filr 3.1: Perform the following steps to create a contract:
1. Log in to the NAM Administration Console.
2. click Devices > Identity Server > Servers > Edit > Local > Contracts.

3. Click New to launch the Create Authentication Method Wizard, then fill in the following
fields:

+ Display name: Specify a name for the contract.

+ Methods: Add the authentication methods that you created before from the list of the
available methods.

4. To save the configuration changes, click Devices > Identity Servers, then click Update All.

5. Continue with Section A.5, “Configuring a Reverse-Proxy Single Sign-On Service for Micro
Focus Filr,” on page 107.
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A.5 Configuring a Reverse-Proxy Single Sign-On
Service for Micro Focus Filr

The Access Gateway can be configured as a reverse proxy server that provides single sign-on to Filr
and restricts access to the Filr server by securely providing credential information for authenticated
users.

To configure a reverse-proxy single sign-on service for Filr, complete the following tasks:

¢ Section A.5.1, “Creating a New Reverse Proxy,” on page 107

+ Section A.5.2, “Configuring the Proxy Service,” on page 107

+ Section A.5.3, “Creating Policies,” on page 108

+ Section A.5.4, “Configuring Protected Resources,” on page 109

+ Section A.5.5, “Configuring a Rewriter Profile,” on page 110

A.5.1 Creating a New Reverse Proxy

You must ensure that the Reverse Proxy that you use for integrating NAM with Filr listens on the
default HTTP (port 80) and HTTPS (port 443) ports.

Before you can configure the proxy service, you need to create a new reverse proxy. See
“Configuring a Reverse Proxy” in the NetlQ Access Manager Administration Guide.

A.5.2 Configuring the Proxy Service

1 In the NAM Administration Console, click Devices > Access Gateways > Edit, then click the
name of the reverse proxy that you created in “Creating a New Reverse Proxy” on page 107.

2 Inthe Reverse Proxy List, click New and then fill in the following fields:
Proxy Service Name: Specify a display name for the proxy service.

Published DNS Name: Specify the publicly-available DNS name for accessing your Filr site.
This DNS name must resolve to the IP address you set up as the listening address. For
example, filr. doc. provo. m crof ocus. com

Web Server IP Address: Specify the IP address of the Filr server.
Host Header: Select Forward Received Host Name.

Web Server Host Name: Because of your selection in the Host Header field, this option is
dimmed.

3 Click OK.

4 Click the newly added proxy service, then select the Web Servers tab.

5 Change the Connect Port to the default HTTP or HTTPS Filr web service port.
6 Click OK.

7 Continue with “Creating Policies” on page 108.
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A.5.3 Creating Policies

108

You need to create two policies: LDAP Identity Injection and X-Forward-Proto:

*

*

“Creating the LDAP ldentity Injection Policy” on page 108
“Creating the X-Forward-Proto HTTP Header Policy” on page 108

Creating the LDAP Identity Injection Policy

1
2
3

In the NAM Administration Console, click Policies > Policies.
Select the policy container, then click New.

Specify | dap_aut h as the name for the policy, select Access Gateway: Identity Injection for the
type, then click OK.

(Optional) Specify a description for the injection policy. This is useful if you plan to create multiple
policies to be used by multiple resources.

In the Actions section, click New, then select Inject into Authentication Header.
Fill in the following fields:

User Name: If users are provisioned with c¢n or ui d attributes, select Credential Profile, then
select LDAP Credentials:LDAP User Name. In the Refresh Data Every drop-down, select
Session.

Password: Select Credential Profile, then select LDAP Credentials:LDAP Password.
Leave the default value for the Multi-Value Separator, which is comma.

Click OK.

To save the policy, click OK, then click Apply Changes.

For more information on creating such a policy, see “Configuring an Authentication Header
Policy” in the NetlQ Access Manager Administration Guide.

Creating the X-Forward-Proto HTTP Header Policy

If your network provides HTTPS (secure) connections between browsers and NAM but HTTP
(insecure) connections between NAM and Filr, we strongly recommend creating an X-Forward-Proto
HTTP Header Policy as a best practice.

1
2
3

In the NAM Administration Console, click Policies > Policies.
Select the policy container, then click New.

Specify x- f or war d as the name for the policy, select Access Gateway: Identity Injection for the
type, then click OK.

(Optional) Specify a description for the injection policy. This is useful if you plan to create multiple
policies to be used by multiple resources.

In the Actions section, click New, then select Inject into Custom Header.
Fill in the following fields:

Custom Header Name: Specify X- For war d- Pr ot 0 as the name.

Value: Select String Constant in the drop-down, then specify ht t ps.
Leave the other settings at the defaults.

Click OK.
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9 To save the policy, click OK, then click Apply Changes.

For more information on creating such a policy, see “Configuring an Authentication Header
Policy” in the NetlQ Access Manager Administration Guide.

A.5.4 Configuring Protected Resources

You must create two protected resources: a protected resource for HTML content and a public
protected resource for web services.

1 Create a protected resource for HTML content:
la Inthe Protected Resource List, click New. Specify a name, then click OK.

1b (Optional) Specify a description for the protected resource. You can use it to briefly describe

the purpose for protecting this resource.
1c Select a contract that suits your requirement.
1d Inthe URL Path List, add the following paths for HTML content:
| *
[ ssfl*
le Click OK.
2 Create a public protected resource for Web Services:
2a In the Protected Resource List, click New. Specify publ i ¢ for the name, then click OK.

2b (Optional) Specify a description for the protected resource. You can use it to briefly describe

the purpose for protecting this resource.
2c For the Contract, select None.
2d Click OK.
2e Inthe URL Path List, remove the / * path and add the following paths for public content:

For Filr 3.0 For Filr 3.1
[ ssf/atonl * | ssf/aton *
/ssflical/l* /ssflical/l*
[ ssf/lws/* | ssf/ws/*
[ ssflrss/* /| ssflrss/*
[ssril* /ssril*
/rest/* /rest/*
/ /
/ davel * / davel *
Imy_files/* Iy _files/*
/ net_fol ders/* /net _fol ders/*
/ shared_wi th_me /shared_wi th_me
/ deskt opapp/ * / deskt opapp/ *
| ssflel*
/ssflstatic/*
/ssflgwt/*
| ssflsl*
| ssflsl/readFil e/ sharel*
/ ssf/appl ets/*

2f Click OK.
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3 Assign the X-Forward-Proto Header policy to both protected resources that you created:

3a Click Access Gateways > Edit > [Name of Reverse Proxy] > [Name of Proxy Service] >
Protected Resources.

3b For each Filr protected resource, click the Identity Injection link, select the x-forward policy
that you created, click Enable, then click OK.

3c Click OK.

4 Assign the Identity Injection policy to the HTML protected resource that you created.

5

6

4a Click Access Gateways > Edit > [Name of Reverse Proxy] > [Name of Proxy Service] >
Protected Resources.

4b For each Filr protected resource, click the Identity Injection link, select the Idap auth policy
that you created, click Enable, then click OK.

4c Click OK.

In the Protected Resource List, ensure that the protected resources that you created are
enabled.

To apply your changes, click Devices > Access Gateways, then click Update All.

A.5.5 Configuring a Rewriter Profile

1

Click Devices > Access Gateways > Edit > [Name of Reverse Proxy] > [Name of Proxy Service]
> HTML Rewriting.

In HTML Rewriter Profile List, click New.

3 Specify a name for the profile, select Word as the search boundary, then click OK.

In the And Document Content-Type Header Is section, click New, then specify the following type:
appl i cation/rss+xm

In the Variable or Attribute Name to Search for Is section, click New, then specify the following
as the variable to search for:

val ue

6 Click OK.
7 In the Protected Resource List, ensure that the protected resources you created are enabled.

8 To apply your changes, click Devices > Access Gateways, then click Update All.
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All-in-One (Small) Deployment—
Creating

To create an all-in-one deployment, you install one Filr appliance. By default Filr also includes the
MySQL database and Filrsearch functions.
Ensuring All-in-One Suitability

With few exceptions, small deployments are only suitable for proof-of-concept deployments, which,
by definition, do not require extensive planning.

For a production deployment, you should use the Filr Planning Your Filr Deployment—Best Practices
guide and associated planning worksheets to gauge whether a small deployment could meet your
organization’s production needs.

The Micro Focus best practice recommendation is always an expandable deployment, which is the
focus of this guide.

All-in-One System Requirements

Most of the requirements in Chapter 3, “System Requirements,” on page 13 apply to small
deployments.

However, minimum RAM and CPU recommendations are increased to handle the database and
search functions running in addition to Filr.

+ 12 GB of RAM (16 GB is recommended)
¢ 4 CPUs.

80% of the RAM should be dedicated to the Java heap.

For information about adjusting the Java heap settings, see “Changing JVM Configuration Settings
in the Filr : Administrative Ul Reference.

All-in-One Deployment

To deploy an all-in-one Filr appliance, complete the instructions in the following sections:

Table B-1

Section

Additional Information

Chapter 5, “Downloading and Preparing the Filr
Software,” on page 27

You only need to download the Filr software for your
virtualization platform.

Chapter 6, “Deploying the Virtual Machines,” on
page 31

Follow the instructions in the section for your
virtualization platform.

Chapter 7, “Starting and Configuring the Appliances,”

on page 45

Follow the instructions in the referenced section, then
continue with
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Setting Up an All-in-One (small) Filr Appliance

Table B-2 Logging in and Setting Up a Small Filr Appliance

Page, Dialog, or Option

Do This

Filr Appliance Sign In

Filr Appliance Tools

Filr Configuration Wizard
Database

Default Locale

1.

Open a management browser on your administrative workstation and access
the Port 9443 Administration Utility on the Filr appliance using the following
URL:

https://filr_I P_Address: 9443
Where IP_Address is the IP address of the Filr appliance.

Log in as the vaadmi n user with the password that you set for the appliance in
“Vaadmin password and confirmation:” on page 47.

%
Click the Configuration icon % | o launch the Filr Configuration Wizard.

Click Next.
Type and confirm a password for the filr user in the MySQL database.

Select your Locale from the dropdown list.

2. Change the Administrator User ID if you want to.

The User ID that you enter is also the password for the initial login for the Port
8443 administration console.

3. Click Finish.

4. Do not close or exit the browser page until the warning message disappears.
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All-in-One (Small) Deployment—
Upgrading

IMPORTANT: Filr 3.1 is only available as an online update to Filr 3.0.

+ To Upgrade to Filr 3.1: Use the instructions in the Filr 3.1 Release Notes to apply the 3.1

update.

Before You Upgrade!

NOTE: As an additional resource to the information in this section, TID 7017288 has a “Pre-Flight
Checklist” that can help you ensure a successful upgrade.

Failure to comply with the following critical points could result in a non-functional Filr system.

*

Review the Release Notes: Check “Upgrade” in the Filr 3 Release Notes before you start the
upgrade process.

Ensure that the VM host has enough unformatted disk space:
+ System Disk (/): A 20 GB disk is created automatically.
+ Disk 2 (/vastorage): You make a copy of the appliance’s Disk 2.

¢ Each Disk 3 (/var): You create this disk. The recommended size is 4 GB plus 3 times the
appliance’s RAM allocation.

Check the version: Make sure that the existing appliance is running version 2.0 with the latest
patches applied (see “Managing Field Test Patches” in the Filr 2.0: Administration Guide)

Remove VMware Snapshots: Before copying Disk 2, make sure to remove all VMware
shapshots so that the / vast or age disk has the correct disk file and latest configuration settings.

If the appliance has two network adapters: Do the following:
1. Download the net wor kpr ep. zi p file from the Filr software downloads page.

2. Enable SSH on the appliance, as described in “Managing System Services” in the Filr :
Administrative Ul Reference.

3. Using an SSH client (such as WinSCP), log in to the appliance as the r oot user.

4. Copy the net wor kpr ep. zi p file that you downloaded to the / r oot/ directory on the
appliance.

5. Unzip the net wor kpr ep. zi p file:
unzi p networkprep. zip
The net wor kpr ep folder is created.

6. Change to the net wor k prep folder:
cd /root/networkprep

7. Run the script:
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sh run-networ kprep. sh

8. Close the remote SSH connection to the appliance.

After ensuring that you have met the prerequisites and cautions above, complete the instructions in
the following sections in order.

¢ Section C.1, “Small Filr Upgrade Process Overview,” on page 114

+ Section C.2, “Downloading and Preparing Software,” on page 114

¢ Section C.3, “Copying Each Appliance’s /vastorage Disk (Disk 2),” on page 116

+ Section C.4, “Upgrading the VMs,” on page 116

¢ Section C.5, “Deploying the Upgraded Filr VM,” on page 125

+ Section C.6, “Performing Filr Post-Upgrade Tasks,” on page 125

C.1 Small Filr Upgrade Process Overview

If you have upgraded a small Filr deployment before, the following reminder might be all you need.

Figure C-1 Overview of the Small Filr Appliance Upgrade Process

4 )

Upgrading a Small Filr Deployment

i i i ) 3 N
o Downloaq anew version of the Filr appliance K/TX rzip or rgz
for your virtualization platform. L
download.novell.com

e Deploy the downloaded file to the new
Filr appliance location.

This creates a new VM with a

G Copy Disk 2 of the existing Filr appliance B MO () (21 )

to the new location.

New Filr Appliance
Note: For Citrix Xen, you “export” Location
rather than copying. /@
M /vastorage A\

. Ivastorage New / New /var
L (Disk 2) (Disk 2) (Disk 1) (Disk 3)
Existing Filr Appliance \ \/

0 Start and configure the newly deployed appliance.
- Add/create a new /var disk. '
- Set the correct RAM. ——
- Add a second network adapter if needed. N . .
ew Filr Appliance

G The appliance system prompts you to confirm that you are upgrading.
After you supply a couple of passwords, the system runs through the configuration screens automatically,
and the new appliance is an “upgraded” version of the old appliance.

C.2 Downloading and Preparing Software

Download and prepare the software for your virtualization platform as described in the following
sections:
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VMWare

1 Download the Filr appliance software to your management workstation.

IMPORTANT: Registration with Micro Focus is required to receive an email with a software-
download link.

2 Extract the . ovf. zi p file on your management workstation until a Fi | r - ver si on folder appears.

3 Launch the vSphere Client and navigate to the datastore where you plan to host the upgraded
VM.

4 Create a folder for the new appliance with a name that is easily associated with (but not the
same as) the VM name of the appliance being upgraded.

5 Continue with Section C.3, “Copying Each Appliance’s /vastorage Disk (Disk 2),” on page 116.

Hyper-V

1 Log in to the Hyper-V host server either locally or from a remote workstation using Remote
Desktop.

2 Download the Filr appliance software to the location where you plan to host your upgraded VMs.

IMPORTANT: Registration with Micro Focus is required to receive an email with a software-
download link.

3 Extract the . vhd. zi p file in the directory where you downloaded it until an Fi | r - ver si on. vhd
archive fil e appears.

4 Create a directory for the new appliance with a name that is easily associated with, but not the
same as the VM name of the appliance being upgraded.

5 Move the Fi | r- versi on. vhd archive file to the folder you just created.
6 Continue with Section C.3, “Copying Each Appliance’s /vastorage Disk (Disk 2),” on page 116.

Xen

1 Log in to the Xen VM host server either locally or from a remote workstation.
If you are connecting from a remote Linux workstation, use the following command:
ssh - X root @ost_i p_address

The -X in the command in required for the GUI installation program upon which the steps in this
section are based.

2 Download the Filr appliance software to the Xen VM host server in the location where you plan to
host your upgraded VM.

IMPORTANT: Registration with Micro Focus is required to receive an email with a download link.

3 Untar the *. gz file in the directory where you downloaded it.
You can use the following command to untar the file:
tar -Sxvzf Filr.x86_64-version.xen.tar.gz
AFi | r-versi on directory is created.
4 Continue with Section C.3, “Copying Each Appliance’s /vastorage Disk (Disk 2),” on page 116.
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C.3

C.A4

C4.1

C.4.2

Citrix Xen

1 On a workstation with Citrix XenCenter installed, download the Filr appliance software.

IMPORTANT: Registration with Micro Focus is required to receive an email with a download link.

2 Using a program such as 7-Zip, extract each . xva. t ar . gz file on your management workstation
until a Fi | r - ver si on folder appears.

3 Continue with Section C.3, “Copying Each Appliance’s /vastorage Disk (Disk 2),” on page 116.

Copying Each Appliance’s /vastorage Disk (Disk
2

IMPORTANT
+ VMware requires shutting down an appliance before copying a disk.

This means that Filr services will be down while disk copying takes place.

+ On Citrix Xen you “export” rather than copying Disk 2.

1 Using the tools provided by your hypervisor, copy the /vastorage (second disk) to its associated
folder or directory that you created for your upgraded appliances in Section C.2, “Downloading
and Preparing Software,” on page 114.

Upgrading the VMs

Shutting Down the Appliance

1 Shut down the Filr appliance using the Port 9443 Appliance Console.
2 Continue with the instructions for your VM platform:

+ Upgrading a Filr VMware VM

+ Upgrading a Filr Hyper-V VM

+ Upgrading and Deploying a Filr Xen VM

+ Upgrading Citrix Xen VMs

Upgrading a Filr VMware VM
Complete the steps in Table C-1.

Table C-1 Upgrading the Filr VMware VM

Page, Dialog, or Option Do This

1 - Launching the vSphere Client.

1. On your management workstation, start the vSphere Client.
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Page, Dialog, or Option Do This

vSphere Client 2 - Deploying the OVF Template and naming the VM.

1. Click File > Deploy OVF Template.

Deploy OVF Template 1. Click Browse.

Open 1. Navigate to the contents of the folder that you downloaded and extracted in
Step 4 on page 115.

2. Select and open the. ovf file.

Deploy OVF Template 1. Name the appliance with the same name of the folder that you created for this
upgraded appliance in Step 4 on page 115.

Click Next.

Choose the datastore and folder were you copied the appliance’s Disk 2.
Click Next to accept the default for the disk format.

Do not select Power on after deployment.

Click Finish.

o 0k~ D

The boot disk is created and the appliance is deployed as specified to this
point.

3 - Editing the VM settings.

vSphere Client 1. In the vSphere Client, right-click the VM and select Edit Settings.

The Virtual Machine Properties dialog displays.

Virtual Machine 1. Setthe Memory and CPU settings to match the appliance you are replacing,
Properties or increase them as planned.

4 - Configuring disk 2 (/vastorage)

Virtual Machine 1. Click Add.
Properties
Add Hardware 1. Select Hard Disk, click Next and select Use an existing Virtual disk.

2. Click Next > Browse, then navigate to and select the copy of disk 2 that you
made for this appliance.

3. Click Next > Next > Finish.

5 - Adding and Configuring disk 3 (/var)

Virtual Machine 1. Click Add.
Properties
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Page, Dialog, or Option Do This

Add Hardware

1. Select Hard Disk.

Click Next > Next.

3. Adjust the Disk Size to the same size as disk 3 (/var) on the appliance you are

© © N o O

10.
11.
12.
13.

replacing.
Under Disk Provisioning, select either:

¢ Thick Provision Eager Zeroed

or

¢ Support clustering features such as Fault Tolerance
Depending on the VMware version that you are running.
Under Location, select Specify a datastore or Datastore cluster
Click Browse.
Select the datastore and folder for this appliance.
Click OK.
Click Next.
Under the Virtual Device Node section, select SCSI (2:0).
Click Next.
Click Finish.

If you need to add network adapters, continue with 6 - (Optional) Adding a
Network Adapter.

Otherwise, click OK and skip to continue with Section C.5, “Deploying the
Upgraded Filr VM,” on page 125.

6 - (Optional) Adding a Network Adapter

You can add a network adapter if your Filr deployment accesses a separate network
for one or more of the following reasons:

*

*

Appliance administration.
Security of memcached.
IMPORTANT: Bonding or teaming NICs is not supported with Filr.

Virtual Machine 1. Click Add.
Properties
Add Hardware 1. Select Ethernet Adapter.
2. Click Next.
3. Under Network Connection, select the secondary network associated with
the Filr installation.
4. Click Next > Finish > OK.
vSphere Client 1. Continue with Section C.5, “Deploying the Upgraded Filr VM,” on page 125.

Upgrading a Filr Hyper-V VM

Complete the steps in Table C-2.
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Table C-2 Upgrading a Filr Hyper-V VM

Page, Dialog, or Option

Do This

1 - Open Hyper-V Manager.

Hyper-V Host Server

1.

Open the Hyper-V Manager.

2 - Create a new VM.

Hyper-V Manager

1.

In the left pane, right-click the server where you have planned to
create the new virtual machine, then click New > Virtual
Machine.

The New Virtual Machine Wizard displays.

Click Next.

Specify Name and Location

Name the appliance with the name of the directory that you
created for it in Step 4 on page 115.

Click Next.

Specify Generation

1. Make sure that Generation 1 is selected.

2.

Click Next.

3 - Specify memory

Assign Memory

1.

2.

In the Startup RAM field, specify the same amount of memory
(in MB) of the appliance that you are replacing, or increase the
memory as planned.

Click Next.

4 - Assign network adapter

Configure Networking

1.

2.

On the Configure Networking page, select the networking card
for this VM.

Click Next.

6 - Identify the system disk

Connect Virtual Hard Disk

1.
2.

Select Use an existing virtual hard disk.

Browse to and select the . vhd file in the folder you created for
this appliance.

3. Click Open.
4. Click Next.

Summary

Click Finish.

The VM is created and appears in the list of Virtual Machines.

7 - Specify processors

Hyper-V Manager

1.
2.

In Hyper-V Manager, right-click the VM that you just created.
Click Settings.

Processor

1. Click Processor.

2. Inthe Number of virtual processors field, specify the number

3.

of processors for the VM.
Click Next.

8 - Use existing copy of hard disk 2 (/vastorage).
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Page, Dialog, or Option Do This

Settings for VM on Host Server 1. Add the copy you made of disk 2 to this VM.

2. When you have added the disk, review the VM summary
information and click Finish.

9 - Add hard disk 3 (/var).

Hyper-V Manager 1. In Hyper-V Manager, right-click the VM that you just created.
2. Click Settings.

3. Create a new blank virtual disk the same size as disk 3 on the
appliance you are upgrading.

Summary 1. Review the summary information.
2. Click Finish > OK

10 - (Optional) Add a Network Adapter

1. If the appliance you are upgrading has a secondary network
adapter, add that now.

Hyper-V Manager 11 - Deploy the upgraded appliance

1. Continue with Section C.5, “Deploying the Upgraded Filr VM,”
on page 125.

C.4.4 Upgrading and Deploying a Filr Xen VM

Complete the steps in Table C-3.

Table C-3 Upgrading and Deploying a Filr Xen VM

Page, Dialog, or Option Do This

1 - Launch the installer.

Terminal prompt on Xen VM Host 1. Run the following command to launch the GUI configuration
Server menu:
vminstall

The Create a Virtual Machine wizard is displayed.

Create a Virtual Machine 1. Click Forward.

Install an Operating System? 1. Select| have a disk or disk image with an installed
operating system.

2. Click Forward.

Type of Operating System 1. Select SUSE Linux Enterprise Server 11.
2. Click Forward.

2 - Name the VM.

Summary 1. Click Name of Virtual Machine.
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Page, Dialog, or Option

Do This

Name of Virtual Machine

1. Inthe Name field, type the name of the appliance.

Use the name of the corresponding directory that you prepared

for the appliance in Step 2 on page 115.

2. (Optional) In the Description field, type additional information

about the appliance.
3. Click Apply.

3 - Specify the RAM and Virtual Processors.

Summary 1. Click Hardware.

Hardware 1. Change the Initial Memory and Maximum Memory set the
amount of memory (in MB) to match that of the VM you are
upgrading.

2. Change the Virtual Processors setting to match the number of
the VM you are upgrading.
3. Click Apply.
4 - Configure the boot disk

Summary 1. Click Disks.

Disks 1. Click the Harddisk button.

Virtual Disk 1. Click the Browse button.

Locate Disk or Disk Image.

1. Navigate to the contents of the folder for the appliance you are

creating.
2. Select the . r awfile.
3. Click Open.

Virtual Disk

1. Click OK.

5 - Configure disk 2 (/vastorage)

Disks

1. Click the Harddisk button.

Virtual Disk

1. Click the Browse button.

Locate Disk or Disk Image.

Select the . r awfile for Disk 2.
Click Open.

.

Virtual Disk

=

Click in the Source field.
Press the End key.

N

3. Use the Backspace key to erase the filename so that the path

ends with the forward slash (/) that follows the appliance’s folder

name.
4. Type a name of the copy of disk 2 for this appliance.
5. When you finish linking to the disk, click OK.

6 - Configure disk 3 (/var)

Disks

1. Click the Harddisk button.

Virtual Disk

1. Click the Browse button.
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Page, Dialog, or Option

Do This

Locate Disk or Disk Image. 1. Select the . r awfile.

2. Click Open.

Virtual Disk 1. Click in the Source field.

2. Press the End key.

3. Use the Backspace key to erase the filename so that the path
ends with the forward slash (/) that follows the appliance’s folder
name.

4. Type a disk name that reflects the appliance name and that this
is disk 3. For example, Filr-192.168.1.61-disk-3.

5. Do not change the Storage Format.

6. Change the Size field value to match the size of disk 3 in the
appliance you are upgrading.

7. Click OK.

Disks 1. Click Apply.

2. If you need to add network adapters, continue with “7 -

(Optional) Add a Network Adapter.”
Otherwise, click OK and continue with “8 - Deploy the
Appliance.”
7 - (Optional) Add a Network Adapter
You can add a network adapter if your Filr deployment accesses a
separate network for one or more of the following reasons:
* Appliance administration.
+ Security of memcached.
IMPORTANT: Bonding or teaming NICs is not supported with
Filr.
Summary 1. Click Network Adapters.
Network Adapters 1. Click New.
Virtual Network Adapter 1. Specify the settings for the adapter.
2. Click Apply.
Network Adapters 1. Click Apply.
Summary 1. Click OK.
The virtual machine is created, the appliance starts, and the
configuration process begins.
Console 8 - Deploy the Appliance

1.
2.

Access the appliance’s console.

When prompted, enter the root and vaadmin passwords for the
appliance.

The upgrade process proceeds automatically.

. When the appliance displays the final screen in the console

window, open your management browser and log in to the
appliance on port 9443 as the vaadmin user.

Filr 3.0 Installation, Deployment, and Upgrade Guide



C.4.5

Page, Dialog, or Option Do This

Port 9443 Admin Console 1. Check the following:
+ MySQL (optional) :
¢ Click the phpMyAdmin icon.

+ Verify that the database is populated as expected.

* Filr:
+ Click the Filr configuration icon.

* Ensure that all of the settings are in place as
expected.

+ |If the configuration wizard displays, there was a
problem with the configuration.

+ Resolve the configuration issues, then click Finish to

reconfigure the system.

Common configuration issues include:

* If your system is not using DNS, the most likely

problem is unresolvable DNS names and
missing /etc/hosts entries.

+ |If the appliance doesn’t have access to the
database, ensure that all of the settings are as

expected.

2. When the appliance is running, continue with “Performing Filr

Post-Upgrade Tasks.”

Upgrading Citrix Xen VMs

Complete the steps in Table C-4.

Table C-4 Upgrading a Citrix Xen VM

Page, Dialog, or Option Do This

1 - Launch XenCenter.

Management 1. Start XenCenter.
Workstation
XenCenter 1. Connect to the Citrix XenServer where you planned to deploy Filr.

2. Right-click the server and select Import.

2 - Import the system disk

Locate the File you want 1. Browse to and select the . xva file on your management workstation.
to import 2. Click Open.
3. Click Next.

Select the location where 1. Select the XenServer.
the imported VM will be Click Next
placed '

N
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Page, Dialog, or Option Do This

Select target storage

1. Select the storage repository for the VM that you used in Step 2 on page 116.
2. Click Import.

3 - Select the network adapter

Select network to 1. Select the virtual network adapter.
connect VM 2. Click Next.
Review the import 1. Deselect Start VM(s) after import.

settings

2. Click Finish.

IMPORTANT: Depending on network latency and other factors, it can take a
while to import the system disk.

4 - Specify Memory

1. If you need to adjust the memory to the amount of memory, select the newly
created VM in the left pane.

2. Click the Memory tab.
3. Click Edit, change the setting, and click OK.

5 - Specify Processors

1. If you need to adjust the CPUs, right-click the newly created VM in the left
pane.

2. Select Properties.
3. Click CPU, change the setting, and click OK.

6 - Link to Disk 2 (/vastorage)

1. With the newly created VM selected in the left pane, add the copy of disk 2 for
this appliance.

8 - Add Disk 3 (/var)

Virtual Disks

1. Click Add....

Add Virtual Disk

1. Type a disk name that reflects the appliance name and that this is disk 3. For
example, Filr-1-disk-3.

2. Change the Size field value to match that of the appliance you are replacing.
3. Click Add.

9 - (Optional) Add a Network Adapter

You can add a network adapter if your Filr deployment accesses a separate network
for one or more of the following reasons:

+ Appliance administration.
+ Security of memcached.
IMPORTANT: Bonding or teaming NICs is not supported with Filr.

1. With the newly created VM selected in the left pane, click the Networking tab.

2. Select the secondary network associated with the Filr installation..

XenCenter

1. Continue with Section C.5, “Deploying the Upgraded Filr VM,” on page 125.
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C.6

C.6.1

C.6.2

Deploying the Upgraded Filr VM

1 Power on the appliance.

2 Access the appliance’s console.

3 When prompted, enter the root and vaadmin passwords for the appliance.
The upgrade process proceeds automatically.

4 When the appliance displays the final screen in the console window, open your management
browser and log in to the appliance on port 9443 as the vaadmin user.

5 Check the following:
* MySQL :
¢ Click the phpMyAdmin icon.
+ Verify that the database is populated as expected.
* Filr:

*

Click the Filr configuration icon.

*

Ensure that all of the settings are in place as expected.

*

If the configuration wizard displays, there was a problem with the configuration.

*

Resolve the configuration issues, then click Finish to reconfigure the system.
Common configuration issues include:

+ If your system is not using DNS, the most likely problem is unresolvable DNS
names and missing /etc/hosts entries.

+ If the appliance doesn’t have access to the database, ensure that all of the
settings are as expected.

6 When the appliance is running, continue with “Performing Post-Upgrade Tasks.”

Performing Filr Post-Upgrade Tasks

After upgrading to a new version of Filr, you should perform the following tasks to ensure a fully
functional Filr system:

+ Section C.6.1, “(Optional) Enable Net Folder Sharing,” on page 125

+ Section C.6.2, “Install Your New Filr License,” on page 125

(Optional) Enable Net Folder Sharing

Folder sharing is a new feature in Filr 3.0 with an Advanced-Edition license installed.

If you have Net Folders where you want users to be able to share folders as well as files, you must
grant folder sharing rights using the Recipient can share folders in this Net Folder with: option as
documented in “Grant Rights dialog” in the Filr : Administrative Ul Reference.

Install Your New Filr License

Upgraded Filr appliances have a 60-day evaluation license installed.

To prevent a service interruption, you must install your new license by following the instructions in
“Installing/Updating the Filr License” in the Filr : Administrative Ul Reference.
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MySQL Appliance—Configuring
(Alternate Practice)

Figure 8-3 illustrates that the MySQL appliance is configured to recognize the Filr appliances and
allow them to connect before they are set up and deployed.

Figure D-1 Deploying MySQL

Prepare the MySQL Appliance
(Alternate Practice)

NFS v3 Server

-

CIFS Server

Or _ mmmm

Exported Directory
for Jvashare on all
Filr appliances

1

download.no

SQL Database

vell.com

.

=
MySQL
Appliance

A

Table D-1 Configuring a MySQL Appliance

Page or Dialog

Do This

IMPORTANT: The following steps assume that you installed and prepared a MySQL
appliance as documented in the previous chapters, in addition to your Filr and
Filrsearch appliances.

1. Using a browser on your management workstation, access the Port 9443
Administration Utility on the MySQL appliance by entering the following URL:

https://mysql _| P_Address: 9443

Where IP_Address is the IP address of the MySQL appliance.
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Page or Dialog

Do This

MySQL Appliance Sign 1. Login as the vaadmni n user with the password that you set for the appliance in
In “Vaadmin password and confirmation:” on page 47.
MySQL Tools 1. Click the phpMyAdmin button to launch the phpMyAdmin utility.
2. Login asroot with password r oot .
phpMyAdmin 1. Under General Settings, click Change Password.
2. Type and retype (confirm) a new password for the phpMyAdmin r oot user,
then click Go.
IMPORTANT: If you click the Generate button, the generated password takes
precedence over your typed passwords.
Be sure to note the generated password and use it when configuring Filr.
3. Click the Users tab.
Users Overview 1. Under New, click Add User.
Login Information 1. Typefilr inthe User Name field.

TIP: You can specify any name for the user and associated database. If you
specify a different name, then when you set up the Filr appliances, you will
need to use that name instead of fi | r.

2. For the Host field, select Use Host Table.

In the Host field, type the IP addresses for each of the Filr appliances that you
will configure.

In the Password and Re-type fields, type and re-type (confirm) a password for
the new fi | r user, then scroll down.

IMPORTANT: You will need this password when you configure the Filr
appliances.

Database for user

1. Select Create database with same name and grant all privileges.

In the bottom right corner of the dialog, click Go.
Afilr userentryis added and the corresponding database is created.

Users Overview

Notice that the filr user is listed with the appliances’ IP addresses shown in the
Host column.

Return to Section 8.3, “Setting Up the Filr Appliances,” on page 58.
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Non-Expandable Deployment—
Creating

The steps required to create a non-expandable Filr deployment are almost identical to those for an
expandable deployment.

Do the following:

1. Begin with Chapter 2, “Planning Is Critical,” on page 11 and complete all of the instructions that
apply to your virtualization platform and plans.

2. Skip Chapter 4, “Setting Up Shared Storage,” on page 23.

3. Follow the instructions in the remaining sections as they apply.

Non-Expandable Deployment—Creating
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OES 2015 NSS AD as a Net Folder
Server

Although both Filr 3.0 and OES 2015 NSS AD support SMB v2, Filr configures Net Folder
connections that point to NSS AD servers to use the SMB v1 protocol.

If you have Net Folder Server connections that point to NSS AD servers, you should change Filr to
use SMB v2 for the connections by doing the following:
1 Ensure that the OES 2015 NSS AD server has the latest patches applied.
2 If SSH is not enabled on the Filr appliance, do the following:
2a Log in to the Filr appliance at https://server _url:9443 as the vaadmi n user.
2b Click System Services, then click SSH > Action > Start.
3 Using an SSH client, log in to the Filr appliance as the root user.
4 Run the following command:
/opt/novel | /filr/bin/famconfig -s ncifsSMB 2
5 Restart famtd by running the following command.

# rcnovel | -famd restart

IMPORTANT: If you do not restart famtd, then the SMB v1 protocol is used for connections
made prior to doing Step 4.

6 For large, clustered deployments, repeat these steps for all of the Filr servers in the cluster

NOTE: To reset the Filr connections with OES 2015 NSS AD servers from SMB v2 back to SMB v1,
run the following commands:

/opt/novel | /filr/bin/fanmtconfig -s ncifsSMB 1

# rcnovel | -famtd restart
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SCSI Controller Type—Changing on
VMware

To change the SCSI controller type on a VMware-based appliance to VMware Paravirtual:

1. Finish the installation and power on the Filr system.

2. Ensure that the Filr system is running. (Log in as the Filr administrator, create a user, and log in
as that user.)

3. Shut down each appliance in the Filr system. (For information about how to safely shut down an
appliance, see “Shutting Down and Restarting the Micro Focus Appliance” in the Filr :
Administrative Ul Reference.)

4. In VMware, change the controller to VMware Paravirtual.

5. Power on each appliance in the Filr system.
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H.1

H.2

Troubleshooting the Filr Installation
and Upgrade

¢ Section H.1, “Unable to Access a Newly Installed Appliance,” on page 135
¢ Section H.2, “The Upgrade Dialog Box Is Not Displayed during an Upgrade,” on page 135

+ Section H.3, “Rolling Back to the Previous Version after an Unsuccessful Upgrade,” on page 136

Unable to Access a Newly Installed Appliance

If you are unable to access a newly installed appliance and you need to change appliance settings,
such as the IP address, use the VACONFIG utility from the Filr command prompt.

For more information, see “Using VACONFIG to Modify Network Information” in the Filr : Maintenance
Best Practices Guide.

The Upgrade Dialog Box Is Not Displayed during
an Upgrade

The following dialog box should be displayed when powering on the new appliance.

vasT

Updating Movell FilrAppliance from version 1.1.1 682 to version 1.2.0.781
1oot Password: Confirm root Passsord:
L ] |
vaadmin Password: Caonfirm vaadmin Password:
| ||
LCancel | [ oK ]

If it is not displayed, the data storage location was not successfully copied or attached to the new Filr
system. Begin the upgrade process again and ensure that you have configured the new Filr system to
point to the data storage location of the source Filr system.
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H.3

H.3.1

H.3.2

Rolling Back to the Previous Version after an
Unsuccessful Upgrade

You can roll the Filr system back to the previous version if the upgrade is unsuccessful.

+ Section H.3.1, “Rolling Back a Small or Non-Clustered Filr System,” on page 136
+ Section H.3.2, “Rolling Back a Clustered Filr System,” on page 136

Rolling Back a Small or Non-Clustered Filr System

You should have created a copy of the data storage location (/vastorage) to be used in the new Filr
system (as described in Section 11.3, “Copying Each Appliance’s /vastorage Disk (Disk 2),” on
page 87).

If you experience complications when upgrading the Filr system, your existing Filr system is still intact
and you are able to power it on at any time.

Rolling Back a Clustered Filr System

A clustered Filr system (multiple Filr appliances) consists of not only a data storage location (/
vast or age), but also shared storage (/ vashar e).

+ “Rolling Back the Data Storage Location (/vastorage)” on page 136

* “Rolling Back the Shared Storage Location (/vashare)” on page 136

Rolling Back the Data Storage Location (/vastorage)

You should have created a copy of the data storage location (/ vast or age) to be used in the new Filr
system (as described in Section 11.3, “Copying Each Appliance’s /vastorage Disk (Disk 2),” on
page 87).

If you experience complications when upgrading the Filr system, the data storage location of your
existing Filr system is still intact.

Rolling Back the Shared Storage Location (/vashare)

After an unsuccessful upgrade, you can roll back the shared storage location (/ vashar e) to the
previous version by reconfiguring clustering on the Filr server:
1 On the Filr appliance that you are rolling back to, log in as the Filr administrator.
https://ip_address: 9443
Replace ip_address with the IP address of your Filr appliance.

2 Sign in to the Filr appliance using the vaadni n user and the password that you set during
installation.

The Micro Focus Filr Appliance landing page is displayed.

%
o

3 Click the Filr Server Configuration icon.

4 Click Clustering.
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5 In the Server Address field, add the port number to the server address of each search index
appliance.

For example, change 172. 17.2.2to 172. 17. 2. 2: 11211
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Third-Party Materials

+ Section I.1, “Growl License,” on page 139

¢ Section 1.2, “Oracle Outside In Technology,” on page 140
+ Section I.3, “ANTLR 3 License,” on page 140

+ Section 1.4, “Colt License Agreement,” on page 141

¢ Section I.5, “Dom4j License,” on page 141

¢ Section 1.6, “iCal4j License,” on page 142

+ Section 1.7, “ICU4J license (ICU4J 1.3.1 and later),” on page 142
+ Section 1.8, “JAXEN License,” on page 143

¢ Section 1.9, “Jung,” on page 143

+ Section 1.10, “ASM,” on page 144

+ Section I.11, “Firebug Lite,” on page 145

Growl License

Copyright (c) The Growl Project, 2004-2011
All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted
provided that the following conditions are met:

+ Redistributions of source code must retain the above copyright notice, this list of conditions and
the following disclaimer.

+ Redistributions in binary form must reproduce the above copyright notice, this list of conditions
and the following disclaimer in the documentation and/or other materials provided with the
distribution.

+ Neither the name of Growl nor the names of its contributors may be used to endorse or promote
products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS “AS |S”
AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE
ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR CONTRIBUTORS BE
LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR
CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF
SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS
INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN
CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE)
ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE
POSSIBILITY OF SUCH DAMAGE.
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Oracle Outside In Technology

Oracle shall inform you of any notices and other instructions that are related to third party
components (including open source software) that are included in a program and/or hardware and
that Oracle is required to distribute with such programs and/or hardware. These notices and other
instructions shall be provided to you in at least one of the following ways, at Oracle’s sole discretion:
(a) automatically installed with the programs or in the installation details; (b) in the program
documentation; (c) in the readme files or notice files; or (d) via a supplemental list. You shall comply
with all instructions related to third party software components (including open source software). If
you reproduce the programs, operating system and/or integrated software, you shall reproduce all
third party notices in an appropriate location in the reproduction and/or in its related documentation
and include any associated source code (to the extent such source code is provided by Oracle), as
required by the applicable notices or as otherwise directed by Oracle?.

PDF documents with complete information about the use of Oracle technology in Filr are located in
the following directory on the Filr server:

/opt/novel I /filr/stellent-converter

ANTLR 3 License

Copyright (c) 2003-2008, Terence Parr
All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted
provided that the following conditions are met

+ Redistributions of source code must retain the above copyright notice, this list of conditions and
the following disclaimer.

+ Redistributions in binary form must reproduce the above copyright notice, this list of conditions
and the following disclaimer in the documentation and/or other materials provided with the
distribution.

+ Neither the name of the author nor the names of its contributors may be used to endorse or
promote products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS “AS IS”
AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE
ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR CONTRIBUTORS BE
LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR
CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF
SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS
INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN
CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE)
ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE
POSSIBILITY OF SUCH DAMAGE.
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Colt License Agreement

Packages cern.colt*, cern.jet*, cern.clhep
Copyright (c) 1999 CERN - European Organization for Nuclear Research.

Permission to use, copy, modify, distribute and sell this software and its documentation for any
purpose is hereby granted without fee, provided that the above copyright notice appear in all
copies and that both that copyright notice and this permission notice appear in supporting
documentation. CERN makes no representations about the suitability of this software for any
purpose. It is provided “as is” without expressed or implied warranty.

Packages hep.aida.*

Written by Pavel Binko, Dino Ferrero Merlino, Wolfgang Hoschek, Tony Johnson, Andreas
Pfeiffer, and others. Check the FreeHEP home page for more info. Permission to use and/or
redistribute this work is granted under the terms of the LGPL License, with the exception that any
usage related to military applications is expressly forbidden. The software and documentation
made available under the terms of this license are provided with no warranty.

Dom4j License

Copyright 2001-2005 (C) MetaStuff, Ltd. All Rights Reserved.

Redistribution and use of this software and associated documentation (“Software”), with or without
modification, are permitted provided that the following conditions are met:

1. 1.Redistributions of source code must retain copyright statements and notices. Redistributions
must also contain a copy of this document.

2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions
and the following disclaimer in the documentation and/or other materials provided with the
distribution.

3. The name “DOM4J” must not be used to endorse or promote products derived from this
Software without prior written permission of MetaStuff, Ltd. For written permission, please
contact dom4j-info@metastuff.com.

4. The name “DOM4J” must not be used to endorse or promote products derived from this
Software without prior written permission of MetaStuff, Ltd. For written permission, please
contact dom4j-info@metastuff.com.

5. Products derived from this Software may not be called “DOM4J” nor may “DOM4J” appear in
their names without prior written permission of MetaStuff, Ltd. DOM4J is a registered trademark
of MetaStuff, Ltd.

6. Due credit should be given to the DOM4J Project (http://www.dom4j.org).

THIS SOFTWARE IS PROVIDED BY METASTUFF, LTD. AND CONTRIBUTORS “AS IS™ AND ANY
EXPRESSED OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE
DISCLAIMED. IN NO EVENT SHALL METASTUFF, LTD. OR ITS CONTRIBUTORS BE LIABLE FOR
ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL
DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR
SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER
CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY,
OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE
USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

Copyright 2001-2005 (C) MetaStuff, Ltd. All Rights Reserved.
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ICal4j License

Copyright (c) 2008, Ben Fortuna
All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted
provided that the following conditions are met:

+ Redistributions of source code must retain the above copyright notice, this list of conditions and
the following disclaimer.

+ Redistributions in binary form must reproduce the above copyright notice, this list of conditions
and the following disclaimer in the documentation and/or other materials provided with the
distribution.

+ Neither the name of Ben Fortuna nor the names of any other contributors may be used to
endorse or promote products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS “AS IS”
AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE
ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR CONTRIBUTORS BE
LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR
CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF
SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS
INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN
CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE)
ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE
POSSIBILITY OF SUCH DAMAGE.

ICUA4J license (ICU4J 1.3.1 and later)

COPYRIGHT AND PERMISSION NOTICE
Copyright (c) 1995-2001 International Business Machines Corporation and others
All rights reserved.

Permission is hereby granted, free of charge, to any person obtaining a copy of this software and
associated documentation files (the "Software"), to deal in the Software without restriction, including
without limitation the rights to use, copy, modify, merge, publish, distribute, and/or sell copies of the
Software, and to permit persons to whom the Software is furnished to do so, provided that the above
copyright notice(s) and this permission notice appear in all copies of the Software and that both the
above copyright notice(s) and this permission notice appear in supporting documentation.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR
IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY,
FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT OF THIRD PARTY RIGHTS.
IN NO EVENT SHALL THE COPYRIGHT HOLDER OR HOLDERS INCLUDED IN THIS NOTICE BE
LIABLE FOR ANY CLAIM, OR ANY SPECIAL INDIRECT OR CONSEQUENTIAL DAMAGES, OR
ANY DAMAGES WHATSOEVER RESULTING FROM LOSS OF USE, DATA OR PROFITS,
WHETHER IN AN ACTION OF CONTRACT, NEGLIGENCE OR OTHER TORTIOUS ACTION,
ARISING OUT OF OR IN CONNECTION WITH THE USE OR PERFORMANCE OF THIS
SOFTWARE.
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Except as contained in this notice, the name of a copyright holder shall not be used in advertising or
otherwise to promote the sale, use or other dealings in this Software without prior written
authorization of the copyright holder.

JAXEN License

Copyright (C) 2000-2002 Bob McWhirter & James Strachan.
All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted
provided that the following conditions are met:

1. Redistributions of source code must retain the above copyright notice, this list of conditions, and
the following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions,
and the disclaimer that follows these conditions in the documentation and/or other materials
provided with the distribution.

3. The name “Jaxen” must not be used to endorse or promote products derived from this software
without prior written permission. For written permission, please contact license@jaxen.org.

4. Products derived from this software may not be called “Jaxen,” nor may “Jaxen” appear in their
name, without prior written permission from the Jaxen Project Management (pm@jaxen.org).

In addition, we request (but do not require) that you include in the end-user documentation provided
with the redistribution and/or in the software itself an acknowledgement equivalent to the following:

“This product includes software developed by the Jaxen Project (http://www.jaxen.org).”

Alternatively, the acknowledgment may be graphical using the logos available at http://
WWW.jaxen.org.

THIS SOFTWARE IS PROVIDED “AS IS” AND ANY EXPRESSED OR IMPLIED WARRANTIES,
INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND
FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE Jaxen
AUTHORS OR THE PROJECT CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT,
INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT
LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA,
OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF
LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE
OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF
ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

This software consists of voluntary contributions made by many individuals on behalf of the Jaxen
Project and was originally created by bob mcwhirter (bob@werken.com) and James Strachan
(jstrachan@apache.org). For more information on the Jaxen Project, please see http://
www.jaxen.org.

Jung

THE JUNG LICENSE
Copyright (c) 2003-2004, Regents of the University of California and the JUNG Project

All rights reserved.
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Redistribution and use in source and binary forms, with or without modification, are permitted
provided that the following conditions are met:

+ Redistributions of source code must retain the above copyright notice, this list of conditions and
the following disclaimer.

+ Redistributions in binary form must reproduce the above copyright notice, this list of conditions
and the following disclaimer in the documentation and/or other materials provided with the
distribution.

+ Neither the name of the University of California nor the names of its contributors may be used to
endorse or promote products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS “AS IS”
AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO
EVENT SHALL THE COPYRIGHT OWNER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT,
INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES
(INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES;
LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND
ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT
(INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS
SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

ASM

Copyright (c) 2000-2005, INRIA, France Telecom
All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted
provided that the following conditions are met:

+ Redistributions of source code must retain the above copyright notice, this list of conditions and
the following disclaimer.

+ Redistributions in binary form must reproduce the above copyright notice, this list of conditions
and the following disclaimer in the documentation and/or other materials provided with the
distribution.

+ Neither the name of the copyright holders nor the names of its contributors may be used to
endorse or promote products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS “AS IS”
AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO
EVENT SHALL THE COPYRIGHT OWNER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT,
INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES
(INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES;
LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND
ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT
(INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS
SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.
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Firebug Lite

Copyright (c) 2006-2007, Joe Hewitt
All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted
provided that the following conditions are met:

+ Redistributions of source code must retain the above copyright notice, this list of conditions and
the following disclaimer.

+ Redistributions in binary form must reproduce the above copyright notice, this list of conditions
and the following disclaimer in the documentation and/or other materials provided with the
distribution.

+ Neither the name of the copyright holders nor the names of its contributors may be used to
endorse or promote products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS “AS IS”
AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO
EVENT SHALL THE COPYRIGHT OWNER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT,
INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES
(INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES;
LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND
ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT
(INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS
SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.
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